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EXECUTIVE SUMMARY 

Butte County meadowfoam (Limnanthes floccosa ssp. californica) is an annual plant that is 

designated as endangered under the California Endangered Species Act and federal 

Endangered Species Act. Butte County meadowfoam is only found in a narrow 28-mile strip 

along the eastern Sacramento Valley in Butte County, and there is a population of Butte County 

meadowfoam located at the California Department of Fish and Wildlife (CDFW) Stone Ridge 

Ecological Reserve (Reserve). Populations of Butte County meadowfoam have been subject to 

historic grazing practices. Grazing took place at the Reserve for many years prior to it becoming 

an ecological reserve, and CDFW has continued this practice to manage vegetation.  

Residual dry matter (RDM) appears to have reduced on the Reserve every year since 2014. 

This reduction could be due to seasonal weather patterns that are less favorable for the 

accumulation of RDM (i.e. drought), trampling of vegetation due to saturated soils in the winter 

and spring of 2017, and removal of more RDM as a result of increased grazing pressures in 

2017. Based on the information currently available, no change in the intensity of grazing from 

what was used in in the 2014-2015 and 2015-2016 grazing seasons appears to be needed at 

this time; however, CDFW should continue to evaluate monitoring results at the end of each 

monitoring year. CDFW should also consider restricting cow access to Pasture 1 of the Reserve 

when wet years occur. 

The monitoring plan presented in this report was implemented from 2015 to 2017, and 

implementation is expected to continue into 2021 or later. Growth and reproduction of a 

considerable number of Butte County meadowfoam and woolly meadowfoam plants occurred 

on the Reserve every year from 2015 to 2017. 2016 was the “best” year for Butte County 

meadowfoam, with the highest number of plants in monitoring macroplots, and 2017 appears to 

have been the “worst” of the three monitoring years for Butte County meadowfoam, with 2015 

somewhere in between. The high number of Butte County meadowfoam plants in 2016 may 

have been due to the relatively low impacts from grazing and trampling in the 2016 growing 

season due to relatively low water availability in Pasture 1 that supports the Butte County 

meadowfoam population, but still with sufficient rainfall in January and March to support growth 

and survival of plants. The most plausible explanation for the lower number of Butte County 

meadowfoam plants in 2017 is increased impacts from grazing and trampling in 2017 due to an 

increase in the number on animals on the Reserve, combined with very wet winter and spring 

conditions that left the ground susceptible to more hoof disturbance from cows.  

The monitoring plan presented in this document should be implemented by CDFW staff at the 

Reserve to facilitate the adaptive management of Butte County meadowfoam. The monitoring 

consists of four primary parts: (1) monitoring spring density of the target species Butte County 

meadowfoam, and a closely related possible indicator species woolly meadowfoam (Limnanthes 

floccosa ssp. floccosa); (2) monitoring RDM in the fall; (3) taking photographs; and (4) 

describing the grazing that took place that year. 
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1. INTRODUCTION  
Butte County meadowfoam (Limnanthes floccosa ssp. californica) is an annual plant that is 
designated as endangered under the California Endangered Species Act and federal 
Endangered Species Act. Butte County meadowfoam is only found in a narrow 28-mile strip 
along the eastern Sacramento Valley in Butte County, including a population of Butte County 
meadowfoam located at the California Department of Fish and Wildlife (CDFW) Stone Ridge 
Ecological Reserve (Reserve) (Figure 1). Populations of Butte County meadowfoam have been 
subject to historic grazing practices. Grazing took place at the Reserve for many years prior to 
becoming an ecological reserve, and CDFW has continued this practice to manage vegetation.  

This protocol should be implemented by CDFW staff at Stone Ridge Ecological Reserve 
(Reserve) in Butte County (Figure 2). The purpose of this monitoring protocol is to facilitate the 
adaptive management of the populations of Butte County meadowfoam at the Reserve. The 
monitoring consists of four parts: 

1. Monitoring spring density of the target species Butte County meadowfoam, and a closely 
related possible indicator species woolly meadowfoam (Limnanthes floccosa ssp. 
floccosa); 

2. Monitoring residual dry matter (RDM) in the fall; 
3. Taking photographs; and 
4. Describing the grazing that took place that year. 

2. ECOLOGICAL MODEL 
See Figure 3 for an ecological model of Butte County meadowfoam. 

2.1. LIFE HISTORY 

Butte County meadowfoam is a winter annual that germinates in the fall after the onset of the 
rainy season and begins to flower by mid to late February. Peak flowering typically occurs in 
early to mid-March. Flowering in Butte County meadowfoam seems indeterminate (i.e., 
flowering continues until the necessary environmental conditions, such as moisture availability, 
are no longer provided). Butte County meadowfoam plants can flower until early April when 
rainfall is sufficient. Regardless of the rainfall, flowering does not typically continue beyond early 
April. Fruit and seed production is staggered throughout the latter part of the flowering season 
into May, when plants begin to die. Dead plants disappear rapidly and are extremely difficult to 
find by late May or June. Butte County meadowfoam persists as dormant seed in the soil from 
April or May until the fall rains commence.  

Water availability influences reproduction in the meadowfoam genus (Brown 1976, Brown and 
Jain 1979). Insufficient moisture limits seed production in the closely related woolly 
meadowfoam (Brown and Jain 1979) and is believed to have this effect on Butte County 
meadowfoam (Jokerst 1988). Butte County meadowfoam regularly produces five seeds per 
flower under ideal moisture conditions, but may produce fewer seeds under less ideal conditions 
(Arroyo 1973).  

Studies of meadowfoam seed dispersal suggest that dispersal is short-range, and seed is 
distributed within vernal pools and swales (Jain 1976, Hauptli et al. 1978). Seed of rosy 
Douglas' meadowfoam (Limnanthes douglasii ssp. rosea) was found to be dispersed in close 
proximity to the mother plant, but some seed migrated up to 20 meters along ephemeral 
drainages, presumably having been carried by flowing water (Jokerst 1988). Similar dispersal  
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Senescence 

 Seed bank likely larger than vegetative 
population, seed dormancy possible 

 In the closely related Limnanthes floccosa 
ssp. floccosa approximately 67% of 
individuals were in seed bank, and 50% of 
those germinated each year   

 No information on predation or disease 

 Typically germinates with onset of fall 
rains  

 Does not persist in areas inundated for 
prolonged periods, that remain wet in 
summer or where water flows swiftly  

 Seedlings often found growing near or 
from underneath cobbles  

 Moisture and temperature likely 
promote germination 

Figure 3. Ecology of Butte County Meadowfoam (Limnanthes 
floccosa ssp. californica) 

 Flowers can appear when there is still water in pools and as pools dry down 

 Blooms in late February, March and into April 

 Primarily self-pollinating, pollen gene flow likely limited 

 Sets seed April, maybe into May 

 0-5 nutlets per flower, 1.1 to 3.8 flowers 
per plant  

 Unusually limited natural seed dispersal, 
by water  

 Moisture stress reduces seed output 

Reproductive 

Seedling 

Seed Bank 

 Plants typically found near bottoms of 
rocky vernal swales and sometimes in 
vernal pools  

 Reports of wide swings in population 
size 

 Excessive grazing noted to cause adverse 
effects, but species has persisted in 
areas with light to periodic heavy grazing 

 Invasive plant species able to invade 
rocky swales may compete for 
light/water/space/nutrients 

 Annual  

 Plants senesce rapidly following reproduction 

Difficult to detect plants 
that are not flowering 
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could be expected for Butte County meadowfoam because most populations occur along 
ephemeral drainages and rocky swales.  

Unlike some meadowfoam species, seed of Butte County meadowfoam is reported to germinate 
easily when properly wetted in petri dishes, with up to 100 percent germination in laboratory 
conditions (Jokerst 1988). Viable woolly meadowfoam seed, on the other hand, does not always 
germinate under the same treatment. The timing and percentage of seed germination in the 
meadowfoam genus is related to the length of exposure to water and patterns of temperature 
change (Jain 1976; Toy and Willingham 1966, 1967). Wide fluctuations of Butte County 
meadowfoam populations in the past, and populations that have been found in areas where 
plants were previously absent indicates that Butte County meadowfoam has some dormancy 
mechanism that activates the seed reserve during favorable conditions (Jokerst 1988). 

Intensive livestock grazing likely has a significant negative effect on Butte County meadowfoam. 
The predominant use of intensive livestock grazing for many years may have eliminated Butte 
County meadowfoam from previously occupied suitable habitat in the past, and numbers of 
Butte County meadowfoam have been reported to increase when grazing has been reduced 
(Jokerst 1988). Butte County meadowfoam has persisted in areas that have received light to 
periodic heavy grazing, so grazing is not necessarily detrimental to the persistence of Butte 
County meadowfoam. Grazing may be beneficial for Butte County meadowfoam by preventing 
or reducing thatch.   

2.2. WOOLLY MEADOWFOAM 

Monitoring both Butte County meadowfoam and woolly meadowfoam is important for several 
reasons. The two species are easily confused and calling attention to both species will help 
ensure that plants are accurately identified and monitors are able to confidently differentiate 
between them in the field. Woolly meadowfoam is also included in CDFW’s California Natural 
Diversity Database and has a California Rare Plant Rank of 4.2, indicating that the taxon is of 
limited distribution or infrequent throughout a broader area in California, and its vulnerability or 
susceptibility should be monitored. Butte County meadowfoam and woolly meadowfoam both 
have similar habitats and life histories; however, woolly meadowfoam is more widespread on 
the reserve than Butte County meadowfoam and therefore it may be easier to detect changes in 
woolly meadowfoam populations than changes in Butte County meadowfoam populations. 
Woolly meadowfoam may prove to be an appropriate indicator for habitat quality at the reserve 
and, in turn, an appropriate indicator species for Butte County meadowfoam.  

3. MANAGEMENT OBJECTIVES 
Measuring above-ground expression of annual plant species such as Butte County 
meadowfoam and woolly meadowfoam will provide a quantitative annual record of the 
populations that may allow important ecological insights into how grazing practices affect the 
species. However, population size/density of annual plant species may not be a good metric for 
making short term management decisions. Because of this, a management objective and 
response for adaptive management based on population size/density is not used.  

Thatch accumulation may be a threat to Butte County meadowfoam at the Reserve. RDM is 
expected to be a habitat indicator that is correlated with the suitability of habitat for Butte County 
meadowfoam, and may therefore be one of the most appropriate metrics to use for making 
management decisions. A management objective for adaptive management based on fall RDM 
is therefore presented below. The management objective should be revisited and revised based 
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upon the results of the monitoring program described in this protocol. The term of the current 
land use agreement for the Reserve will end on May 31, 2018. 

Grazing animals that are used for vegetation control may eat and trample Butte County 
meadowfoam and other rare plants and disturb their habitat, and are therefore a direct impact to 
Butte County meadowfoam. Photomonitoring in the spring is used to qualitatively evaluate the 
general condition of Butte County meadowfoam habitat and document the impacts of trampling.  

The management objectives are: 

 Management Objective #1: Prevent the RDM of all Stone Ridge Ecological Reserve 
macroplots that are known to contain Butte County meadowfoam from exceeding 1000 
lbs/acre in two consecutive years.  

 Management Objective #2: Prevent grazing-related disturbances from impacting the 
ability of Butte County meadowfoam and other rare plants to maintain healthy self-
sustaining populations at Stone Ridge Ecological Reserve. 

4. MONITORING DESIGN 

4.1. SPRING DENSITY MONITORING 

The following sections provide instruction on how to implement this monitoring protocol. As part 
of the protocol, you will monitor the density of Butte County meadowfoam and the related woolly 
meadowfoam within specific macroplots. Conduct the spring density monitoring when Butte 
County meadowfoam and woolly meadowfoam are evident and easily identifiable, likely in 
March. 

 SAMPLING OBJECTIVE 

We want to be 90 percent confident that our population estimate for each macroplot is within 20 
percent of the estimated true value. 

 BEFORE GOING INTO THE FIELD 

Before going into the field read this protocol, identify random quadrats to sample, recruit field 
helpers (a total of 4 workers is ideal), and organize your field equipment 

Identify random quadrats to sample 

You will need to collect density data on Butte County meadowfoam and woolly meadowfoam 
from within four macroplots. This data can be collected by counting every Butte County 
meadowfoam and woolly meadowfoam plant within the macroplot, or by sampling random 
locations within the macroplot. Each macroplot is named with an uppercase letter (A-D). The 
locations of the four macroplots are presented in Figures 2 and 4, and the sizes of these 
macroplots are presented in Table 1, below. 
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*
Macroplot A Latitude Longitude

East Corner 39.8095125 -121.8457486
North Corner 39.8096457 -121.8463077
South Corner 39.8086653 -121.8461385
West Corner 39.8087971 -121.8466970

Macroplot B
Northeast Corner 39.8137140 -121.8437470

Northwest Corner 39.8137236 -121.8440378
Southeat Corner 39.8132612 -121.8437427

Southwest Corner 39.8132724 -121.8440342
Macroplot C

Northeast Corner 39.8059556 -121.8482717
Northwest Corner 39.8059522 -121.8488522
Southeast Corner 39.8050654 -121.8482581

Southwest Corner 39.8050550 -121.8488416
Macroplot D

Northeast Corner 39.8072569 -121.8474498
Northwest Corner 39.8072523 -121.8475893
Southeast Corner 39.8068168 -121.8474876

Southwest Corner 39.8068098 -121.8476257

Macroplot Latitude/Longitude Coordinates (NAD83)
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Macroplot Size 
(m) 

Orientation 
of long edge 

Corner Locations (UTM)  
(Easting, Northing) (NAD83) 

Subspecies of 
Limnanthes floccosa 
known to be present 
2015-2017 

A 100x50 20°-200° 
 

North: 598752.95, 4407266.70 
East: 598801.00, 4407252.53 
South: 598768.84, 4407158.07 
West: 598720.84, 4407172.07 

ssp. floccosa 
ssp. californica 

B 50x25 0°-180° Northeast: 598966.32, 4407721.07 
Southeast: 598967.33, 4407670.82 
Southwest: 598942.36, 4407671.73 
Northwest: 598941.41, 4407721.81 

ssp. floccosa 

C 100x50 0°-180° Northeast: 598590.11, 4406854.97 
Southeast: 598592.54, 4406756.18 
Southwest: 598542.61, 4406754.38 
Northwest: 598540.42, 4406853.95 

ssp. californica  
ssp. floccosa 

D 50x12 0°-180° Northeast: 598658.6, 4407000.3 
Southeast: 598655.99, 4406951.41 
Southwest: 598644.18, 4406950.48 
Northwest: 598646.67, 4406999.64 

ssp. californica 

Table 1. Locations of Stone Ridge Ecological Reserve Limnanthes Monitoring Macroplots 

Macroplot A: The size of Macroplot A is 100 meters by 50 meters. The quadrat size is 50 meters 
by 0.25 meters (Figure 5). You need to select random locations for the quadrats within the 
macroplot using restricted random sampling. Divide the macroplot into equal-sized smaller 
segments that are perpendicular to the long (100 meter) edge of the macroplot. The edge could 
be divided into 20 segments so each segment represents 5 meters of the long edge of the 
macroplot, or the edge could be divided into 25 segments of 4 meters each or 40 segments of 
2.5 meters each, etc. If you divide the macroplot edge into 20 segments there will be 20 
(5/0.25= 20) possible places for the quadrat to be located within each 5 meter segment. 
Therefore you need to generate a random number from 0-19 and multiply it by 0.25 meter to 
determine where the quadrat should be located in that 5 meter segment. For example, if you 
generate a random number from 0-19 for the first segment (let’s say it is 13), you would multiply 
it by 0.25 (3.25 meters) so the first quadrat would start 3.25 meters from the origin of the 
macroplot. Generate random locations for the quadrat within each additional segment. For 
example, the position of the second segment’s quadrat would be calculated in the same way as 
the position for the first segment, but you would need to add 5 meters to the result, because that 
segment would start at 5 meters from the origin (see example below from Figure 7.21 from 
Elzinga et al. 1998). 

Macroplot B: The size of Macroplot B is 50 meters by 25 meters, and the quadrat size is 25 
meters by 0.25 meters (Figure 5). You need to select random locations for the quadrats within 
this macroplot.  Do this using restricted random sampling in much the same way that was done 
for Macroplot A. In 2015, the long edge of Macroplot B was divided into 20 segments with each 
segment representing 2.5 meters.  

Macroplot C: The size of Macroplot C is 100 meters by 50 meters (Figure 5). Due to the low 
density of Butte County meadowfoam in Macroplot C, a quadrat size of 50 meters by 1 meter  
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Figure 5: Sizes of Macroplots and Possible Sizes of Quadrats 

 



12 

California Department of Fish and Wildlife   Stone Ridge Ecological Reserve Butte County Meadowfoam Monitoring Plan 

was used in 2015, and random locations for the quadrats was selected using restricted random 
sampling in much the same way that was done for Macroplots A and B. In 2016 and 2017 all  

Butte County meadowfoam and woolly meadowfoam plants within the macroplot were censused 
(i.e. we counted every plant) and therefore no sampling within Macroplot C was necessary. To 
aid in counting we used meter tapes to divide Macroplot C into smaller segments and counted 
all of the meadowfoam plants within each segment. A 1-meter wide segment was found to be 
ideal for efficiency and ease of counting. 

Macroplot D: The size of Macroplot D is 50 meters by 12 meters (Figure 5). Due to the relatively 
small size of Macroplot D, all of Butte County meadowfoam plants in the plot were censused in 
2015, 2016 and 2017, and therefore no sampling of Macroplot D was necessary.  

Calculate the locations of the quadrats in macroplots in the office before fieldwork, and type all 
of the locations in the blank datasheets saved on the shared drive so you don’t have to do this 
in the field. Save and print the datasheets with the randomly-selected quadrat locations for later 
use in the field. 

Organize Field Equipment  
(Figure 6):  

a) (2+) 100 meter tapes  
b) (2+) 50 meter tapes 
c) Screwdrivers or other tools 

for pinning meter tapes to 
the ground 

d) (many) Pin Flags 
e) (2+) Lengths of PVC (0.25 

meter) 
f) (2+) Lengths of PVC (1 

meter) 
g)  (3+) Hand tally counters 
h) Data sheets, clipboards, 

pencils 
i) Replacement field markers 

(aluminum conduit and/or 
rebar with caps and lengths 
of pvc) 

j) PVC cutter 
k) Tape measure 
l) Small sledgehammer 
m) GPS for relocating field markers and documenting plant locations 
n) Tripod and camera 
o) Compass 
p) Zip-lock bags and/or plant press 
q) Metal detector for relocating missing field monument locations (not pictured) 

 IN THE FIELD 

Locate Macroplots 

Contact the reserve manager prior to your visit (Henry Lomeli in 2017). Drive to and park at the 
access gate on Cohasset Road:    

Figure 6: Spring Field Equipment 

a b 

d 

e 

f 

 

g 

h 

i 

i 
j 

k 

l 

m 

n 

o 

p 

c 
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 Lat/Long: 39°48'13.00"N, 121°50'55.96"W 

 Google Maps: https://www.google.com/maps/@39.8035763,-
121.8488831,65m/data=!3m1!1e3?hl=en 

 See Figure 2 

All macroplots can be reached on foot from the parking area/access point. Climb over the gate.  

Macroplot A is in Pasture 1 and can be reached from immediately inside the main gate by 
following the tire track use-road that goes to the northeast. After walking along this track for 
about ½ mile, Macroplot A will be to the left. Be sure to have the coordinates of each of the four 
Macroplot A corners and a handheld GPS receiver with you before going into the field, because 
GPS may be necessary to relocate the field markers. In the spring of 2015 each corner of 
Macroplot A was marked with an approximately 50 cm-long rebar stake, hammered into the 
ground, surrounded by white PVC pipe and capped with a red plastic rebar cap.  

Macroplot B can be reached from inside the main gate by following the tire track use-road that 
goes to the northeast towards Pasture 2. The tire track use-road will lead to a gate between 
pastures 1 and 2. Macroplot B is approximately 200 meters past the gate on the right side of the 
road.  In the spring of 2015 each corner of Macroplot B was marked with an approximately 50 
cm-long rebar stake, hammered into the ground, surrounded by white PVC pipe and capped 
with a red plastic rebar cap.  

Macroplot C is the closest macroplot to the parking area and can be reached by walking 
approximately 150 meters north of the parking area along the rock wall. The northwest and 
southwest markers for this macroplot are hammered flush to the ground, and backup markers 
have been placed 2 meters west of the corner of Macroplot C, directly under the barbed wire 
fence. It will likely be easier to find the backup markers and measure 2 meters east from them to 
identify the macroplot corners.  

Macroplot D is between Macroplots C and A, and straddles a vernal swale.  

Some markers may be missing due to cows or vandalism, and relocating the markers may be 
difficult. In addition to the rebar/pvc markers, two 20 cm-long magnetic nails were hammered 
flush to the ground approximately 10 cm to the north, south, east and west of each macroplot 
field marker. These nails are backup markers, and will likely be difficult to relocate without the 
aid of a metal detector. 

If any markers are missing, use GPS, a metal detector, distance from other markers, or other 
means to relocate and replace them. 

Identify Meadowfoam Subspecies 

Butte County meadownfoam and woolly meadowfoam look very similar, but there are some 
ways to tell them apart. 

The best ways: 

 Pull apart the flower petals to examine the nutlets. The nutlets of Butte County 
meadowfoam are bumpy (papillate) (Figure 7, Photo 1), whereas the nutlets of woolly 
meadowfoam have awl-shaped projections (tubercles) on them (Figure 7, Photo 2).  

 Remove one of the petals and use a hand lens to look for tiny hairs on the inner 
(adaxial) surface of the petal near the base: Butte County meadowfoam has hairs 
(Figure 8, Photo 3), woolly meadowfoam does not have hairs. 

https://www.google.com/maps/@39.8035763,-121.8488831,65m/data=!3m1!1e3?hl=en
https://www.google.com/maps/@39.8035763,-121.8488831,65m/data=!3m1!1e3?hl=en


 

Figure 5 
Photos of Limnanthes floccosa Nutlets 
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Photo 1: Bumpy (papillate) nutlets of Limnanthes floccosa ssp. californica 

 

Photo 2: Awl-shaped projections (tubercles) on nutlets of Limnanthes floccosa ssp. 

floccosa 



Figure 6 
Photos of Limnanthes floccosa Petals 
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Photo 3: Petal hairs of Limnanthes floccosa ssp. californica 

 

Photo 4: Limnanthes floccosa ssp. californica 
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Other, more subjective ways: 

 The flowers of woolly meadowfoam are generally grouped closer together on the plant, 
are on generally shorter pedicels of roughly equal lengths, mostly from the uppermost 
portions of the stem, and flowers are generally clustered into groups of 3-6 during 
flowering. The flowers of Butte County meadowfoam are on longer pedicels of variable 
lengths, some from the lower portion of stem, and flowers are generally not clustered 
into bunches during flowering (Figure 9). 

 The sepals of Butte County meadowfoam are generally hairier near the base, and less 
hairy near the tip. The sepals of woolly meadowfoam are hairier than Butte County 
meadowfoam in general, and this is most easily observed near the tips of the sepals 
(Figure 9). 

Collect Data 

For Macroplots A-C, string out meter tapes along both of the long edges of the macroplot, with 
the 0 meter mark placed farthest to the north. Make sure that the meter tapes are straight and 
taught, and it is very helpful if the side of the tape with the meter marks is facing up. String 
another meter tape perpendicular with and between the two parallel meter tapes, and align zero 
edge with the distance associated with the first quadrat (e.g. 1.25 meters). Make sure that the 
meter tape is taught and straight. Use an appropriate length of PVC pipe (0.25 meter or 1 
meter), and walk along the meter tape using the length of the PVC as your guide to determine 
what is inside the quadrat and what is not. Count the number of Butte County meadowfoam and 
woolly meadowfoam plants within the quadrat using a hand tally counter. Two people may count 
plants in one quadrat simultaneously if they start at opposite ends and work towards the center. 
Follow the counting rules in the box below: 

 If the rooted portion of a plant is within the quadrat, then the plant is counted as being in 
the quadrat. If the rooted portion of a plant is outside of the quadrat, then the plant is not 
counted as being in the quadrat. 

 If the rooted portion of a plant is underneath a meter tape, then the plant is not counted 
as being in the quadrat.  

 If the rooted portion of a plant is right on the outside edge of the PVC (farthest from the 
perpendicular meter tape), then the plant is counted as being in the quadrat. If the rooted 
portion of a plant is right on the edge of the perpendicular meter tape, then the plant is 
not counted as being in the quadrat. 

 If two flower stems are coming out of the ground from the same hole, but they cannot be 
seen as being joined, they count as two different plants.  

 It is very difficult to detect plants that are not flowering; however, if a plant that is not 
flowering is detected, it should be identified to subspecies if possible, and counted.  

Record the number of Butte County meadowfoam and woolly meadowfoam plants counted in 
each quadrat on the appropriate datsheet, and be sure to fill out all fields on the datasheet and 
take any other necessary field notes.  

For Macroplot D, you will need to count all of the Butte County meadowfoam and woolly 
meadowfoam plants that are present. It is likely easiest to do this by dividing the macroplot into 
1 meter wide segments, and counting all of the plants in each segment separately. Make sure 
that plants near the edges of segments are not double counted. Record the number of Butte 
County meadowfoam and woolly meadowfoam plants counted on the datasheet. 

  



 

Figure 9 
Photos of Immature Limnanthes floccosa Plants 
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Photo 5: Immature Limnanthes floccosa ssp. californica plant 

 

Photo 6: Immature Limnanthes floccosa ssp. floccosa plant 
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Before you leave the field site complete a qualitative monitoring datasheet and take monitoring 
photos for each macroplot that you collected data from (see Section 4).  

 BACK IN THE OFFICE 

 Scan, save and re-name all field data sheets. The current project folder is: 
U:\groups\HCPB\Shared Folders\NPP\Section 6\2014\Project Files\BCM Files\Stone 
Ridge. The project folder may change in the future.  

 Enter the field data into Excel spreadsheets, analyze the data and make sure that the 
sample statistics are being calculated correctly. Record results and sample statistics in 
the Excel spreadsheet located on the shared drive in the following location: 
U:\groups\HCPB\Shared Folders\NPP\Section 6\2014\Priority Plant Surveys\Project 
Files\BCM Files\Stone Ridge\Monitoring Data. The Project folder may change in the 
future. 

 Compare the results with previous years and make graphs of the data. Make 
conclusions. Think. Talk to the reserve manager about adaptive management of the site. 
This is the most important part of adaptive management! 

 Download and rename field photos (see Section 4) and compare them with monitoring 
photos from previous years.  

4.2. ANNUAL MONITORING FOR ADAPTIVE MANAGEMENT OF 

RESIDUAL DRY MATTER 

As part of the monitoring protocol, the weight of residual dry matter (RDM) will be monitored 
within specific macroplots. The fall RDM monitoring should be conducted after most annual 
plants except summer-flowering annuals have dried up and died, but prior to any significant fall 
or winter rains, likely in September or October. The material should be dry when it is collected. 

 SAMPLING OBJECTIVE 

We want to be 90 percent confident that our RDM estimate for each macroplot is within 20 
percent of the estimated true value. 

 BEFORE GOING INTO THE FIELD 

Before going into the field you should read this protocol, identify random quadrats to sample, 
recruit field helpers (a total of 4 people is ideal), and organize your field equipment 

Identify random quadrats to sample 

RDM will be sampled within four macroplots. Each macroplot is named with an uppercase letter 
(A-D). The locations of the macroplots are presented in Figures 2 and 4, and more information 
on these macroplots is presented in Section 1, above. Within each macroplot RDM will be 
clipped from several 1 square foot quadrats using the University of California Guidelines for 
Residual Dry Matter on Coastal and Foothill Rangelands in California (Bartolome et al. 2006).  
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Use systematic sampling to identify the quadrats to sample within each macroplot. An example 
of systematic sampling can be seen in Figure 7.18, below, from Elzinga et al. 1998. 

  

Because the quadrat size is 1 square foot, the edges of the macroplots must be converted from 
meters to feet (Table 2)  

Macroplot Dimensions in 
Meters 

Dimensions in Feet 

A 100 x 50 328 x 164 

B 50 x 25 164 x 82 

C 100 x 50 328 x 164 

D 50 x 12 164 x 39 

   Table 2: Unit Conversion of Macroplot Dimensions  

In 2015 the long edges of Macroplots A and C were divided into 8 segments (41 feet in each 
segment), the long edge of Macroplot B was divided into 4 segments (41 feet in each segment), 
and the long edge of Macroplot D was divided into 8 segments (20 feet in each segment). For 
each macroplot generate a systematic random start for the transects, which will allow you to 
identify the locations of each transect in the macroplot. Then for each transect, generate a 
systematic random start for the first quadrat along the transect, which will allow you to identify 
the locations of each subsequent quadrat along that transect, similar to the example in Figure 
7.18 from Elzinga et al. 1998. 

After you have identified the locations of all of the quadrats you will be clipping, create data 
sheets in the office so that you have all of the information you need in the field.   

Organize Field Equipment 

 (2+) 100 meter tapes (the tape must also have feet markings) 

 (2+) 50 meter tapes (the tape must also have feet markings) 

 Screwdrivers or other tools for pinning meter tapes to the ground 



20 

California Department of Fish and Wildlife   Stone Ridge Ecological Reserve Butte County Meadowfoam Monitoring Plan 

 (many) Pin Flags 

 (2+) 1 square foot PVC or metal wire quadrat (1’ x 1’) 

 (2+) Good scissors for clipping material 

 (100+) paper lunch bags 

 (5+) Large grocery bags or garbage bags for collecting the filled lunch bags 

 (2) staplers with replacement staples for stapling bags closed 

 (3+) Sharpie Pens 

 Data sheets, clipboards, pencils 

 Replacement field markers (aluminum conduit and/or rebar with caps and lengths of pvc) 

 PVC cutter 

 Sledgehammer 

 GPS for relocating field markers and documenting plant locations 

 Tripod and camera 

 Compass set to the correct declination for the site (14 degrees east) 

 Zip-lock bags and/or plant press 

 IN THE FIELD 

Locate Macroplots 

Contact the reserve manager prior to your visit (Henry Lomeli in 2017). Drive to and park at the 
access gate on Cohasset Road:  

 Lat/Long: 39°48'13.00"N, 121°50'55.96"W 

 Google Maps: https://www.google.com/maps/@39.8035763,-
121.8488831,65m/data=!3m1!1e3?hl=en 

 See Figure 2, and the description of “Relocating the macroplots” in Section 1 of this 
document, above. 

If any markers are missing, use GPS, a metal detector, distance from other markers, or other 
means to relocate and replace them 

Collect Data 

String out measuring tapes along both of the long edges of each macroplot, with the 0 mark 
always placed farthest to the north. Make sure that the tapes are straight and taught, and it is 
very helpful if the side of the tape with the feet marks is facing up. String another measuring 
tape perpendicular to the other two measuring tapes with the 0 mark always placed farthest to 
the West, and align the edge with the distance associated with the first transect (e.g. 25 feet). 
Make sure that the measuring tape is taught and straight. Place pin flags at the appropriate 
locations along the measuring tape, representing the northwestern corners of the quadrats to be 
clipped. It is efficient if two field helpers are responsible for laying measuring tapes, placing pin 
flags, marking the flags with the quadrate coordinates, while two other field helpers are 
responsible for clipping the quadrats, bagging RDM, and labeling the bags. Before you leave the 
field site, take monitoring photos for each macroplot that you collected data from (see Section 
4). 

Clip Quadrats  

Once you have located a quadrat to be clipped clip plots according to the following instructions, 
adapted from Bartolome et al. 2006: 

https://www.google.com/maps/@39.8035763,-121.8488831,65m/data=!3m1!1e3?hl=en
https://www.google.com/maps/@39.8035763,-121.8488831,65m/data=!3m1!1e3?hl=en
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1. Place the quadrat (1 square foot) on the ground surface. 
2. Remove from the area within the quadrat all summer-flowering annuals such as tarweed, 

yellow starthistle, and turkey mullein and other live plants. 
3. Remove tree leaves. 
4. Clip the remaining RDM within the quadrat as close to the ground surface as you can 

without disturbing the soil. 
5. Rapidly collect as much of the RDM as is practical without inadvertently including bits of 

soil. 
6. Place the RDM in a paper lunch bag, staple the bag closed, and use a permanent marker 

to write the macroplot letter and sampling location coordinates on the bag (e.g. “A: 25, 
59”). Collect all filled lunch bags in large grocery bags for ease of transportation. 

7. Complete a qualitative monitoring datasheet and take monitoring photos for each 
macroplot that you collected data from (see Section 4).  

8. Take the garbage bags filed with the labeled paper bags back to the office for weighing. 

 BACK IN THE OFFICE 

Download and rename field photos (see Section 4).  

Systematically weigh the RDM from each bag (do not include the weight of the bag). Use a 
scale that is sensitive to at most 0.1 or 0.01 gram. Write the weight of the RDM from each 
quadrat (to the nearest 0.1 or 0.01 gram) in the appropriate location on the data sheets. Scan 
the completed data sheets and save them in the project folder. Enter the data into a 
spreadsheet to calculate the average RDM and sample statistics. Check to make sure that the 
Excel spreadsheet is working correctly and double check your work. Spreadsheets from past 
years of monitoring can be found in the project folder on the shared drive 
(U:\groups\HCPB\Shared Folders\NPP\Section 6\2014\Project Files\BCM Files\Stone 
Ridge\Monitoring Data\2015\RDM Monitoring 2015 October). 

Compare the results with previous years, with spring density data and grazing regimes. Make 
conclusions. Think. Make graphs. Talk to the reserve manager about the management of the 
site. This is the most important part of adaptive management! 

4.3. ANNUAL PHOTOMONITORING FOR ADAPTIVE MANAGEMENT 

Photomonitoring should be conducted for a macroplot whenever density data (Section 1) or 
RDM data (Section 2) is collected for that macroplot.  

 BEFORE GOING INTO THE FIELD 

The monitor conducting the photomonitoring should be trained and familiar with the proper use 
of a field compass and whatever digital camera and tripod will be used. The following equipment 
is required: 

 Clipboard with photomonitoring log sheets (Section 5)  

 Pencil 

 Digital camera with fully-charged batteries and available memory  

 Tripod  

 Tape measure or meter tape 

 Compass set to the correct declination for the site (14 degrees east) 

To duplicate approximately the same field of view from year to year, the camera should be set 
to a focal length that is equivalent to a focal length of approximately 27mm on a “full frame” 
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camera such as a 35mm film camera or a Nikon “FX” camera and lens. Monitoring photographs 
for the initial 2014 photomonitoring were taken using a Nikon “DX” camera and lens, set to a 
focal length of 18mm, which is equivalent to 27 mm on a “full frame” camera and lens. Before 
visiting the site, check the specifications for digital cameras that may be used for the monitoring 
to see if photographs can be taken with the correct field of view. If the camera equipment to be 
used cannot duplicate this field of view, the closest field of view possible should be used.  

 IN THE FIELD 

Photographs should be taken from the four corner markers of each macroplot. Three 
photographs should be taken from each macroplot corner, each one directed at one of the other 
corners of the macroplot.  

 Set up the tripod and camera so that the center of the camera lens is 5 feet (152cm) 
from the ground (the maximum height for many tripods).  

 Populate Each Page of the Photomonitoring Log with the date, photographer name, 
focal length, camera, lens and camera settings.  

 Take a “Slate” Photo of the first page of the Photomonitoring Log sheet itself before 
taking all of the monitoring photos on that page. Take a photo of the next page of the 
Photomonitoring Log before taking all of the photos that are listed on that page, and so 
on, until all monitoring photos have been taken. 

 Take monitoring photos in the order that they are listed on the Photomonitoring Log 
and move between the photomonitoring locations. Follow these rules: 

o Use the field compass to ensure that all photos are taken in the direction 
indicated in the Photomonitoring Log. 

o Make sure that the camera focuses properly before taking each picture, and use 
the preview function of the camera to make sure that the photos are being taken 
correctly. 

o Take each of the photographs so that the subject of the photo or the horizon is 
approximately 1/4 of the way down from the top of the frame, so that more of the 
ground is incorporated into the photo.  

o Ensure that the horizon as is level as possible in the viewfinder.  

    

    

    

    

Center the photo subject or horizon in the camera viewfinder at area shown with red arrow. 

 BACK IN THE OFFICE 

Save all monitoring photos in the in the project folder on the shared drive in the folder for that 
date’s field visit, for example: “U:\groups\HCPB\Shared Folders\NPP\Section 6\2014\Priority 
Plant Surveys\Project Files\BCM Files\Stone Ridge\Monitoring Data\2016\031816 (Macroplot 
C)”  
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Carefully change the file names for the monitoring photos using the following convention: 
[uppercase letter of macroplot][lowercase letter of the photopoint][last two digits of year][two 
digit month][two digit day of the month]. For example if a photo is taken at photopoint j of 
Macroplot A, on March 12, 2015 the file should be named “Aj20150312”. 

All properly named monitoring photos should be saved in the following folder on the shared 
drive: U:\groups\HCPB\Shared Folders\NPP\Section 6\2014\Priority Plant Surveys\Project 
Files\BCM Files\Stone Ridge\All renamed photos here for comparison. The location of this 
folder may change in the future. 

With the monitoring photos saved, use the Windows Photo Viewer program and the left and 
right arrow keys on the keyboard to compare monitoring photos with those taken during 
previous site visits and look for signs of excessive impacts from grazing and other differences. 
Think. Talk to the reserve manager about the management of the site. This is the most 
important part of adaptive management! 

4.4. DOCUMENTATION OF GRAZING 

CDFW has a land use agreement with a grazing operator for the removal of vegetation from the 
Reserve. The land use agreement expires on May 31, 2018. The agreement allows cattle to be 
on the site from December 1 through May 31 (6 months). Grazing is limited to no more than 360 
animal unit months (AUMs) per year (60 AUMs/month multiplied by 6 months = 360 
AUMs/year). Weaned calves and light steers between 350-600 pound weight class are each 
counted as 0.7 animal unit and bulls, cows, cows with calves, and steers over 600 pounds are 
counted as 1.0 animal unit.  

If CDFW staff are able to hike around the reserve, they should conduct a rough count of animals 
present on the site.  

At the end of each grazing period, the following information should be recorded and saved in the 
project folder: 

 The actual number and size classes of animals present on the site.  

 The dates that animals were actually added to and removed from the Reserve, including 
dates for any animals that were added late or removed early. 

 The dates that pasture gates were opened and closed and the purposes for opening and 
closing them.  

 The dates that supplemental water was brought to the site (if any), and the locations 
where it was placed.  

 The dates of any efforts to herd animals to specific portions of the site, the locations 
where animals were herded from and herded to, and the reason for herding them.   

 Any other information on grazing-related activities that took place.  

The Reserve manager may decide to change the management of the Reserve based on the 
results of the monitoring described in this document. The Reserve manager could change the 
timing or intensity of grazing, or implement supplemental measures such as providing 
supplemental water for animals, herding animals to specific locations, or fencing areas to 
exclude grazing. The end of a grazing lease period may be the most appropriate time to adjust 
the timing and/or intensity of grazing.  
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5. RESPONSIBLE PARTIES 
CDFW staff in the Native Plant Program or North Central Region (Region 2) should implement 
this monitoring protocol and report results and recommended actions annually to the Reserve 
manager. The Reserve manager should make decisions on how to adaptively manage the 
Reserve. 

6. FUNDING 
CDFW staff in the Native Plant Program used grant funding to prepare this protocol and collect 
monitoring data from 2015 to 2017. Continuation of this monitoring protocol is likely dependent 
on the ability of staff in the Native Plant Program to use staff time funded by the endangered 
species tax check off fund, general fund, and other programs to do so. Field helpers can often 
be borrowed from other CDFW programs if the appropriate program managers approve the 
work as cross training for their staff. Implementation of this monitoring protocol could also be 
implemented by staff in CDFW’s North Central Region or by CDFW volunteers. It is estimated 
that annual implementation of this protocol will require the following: 

Spring Field Work: 112 hours 

In-office preparations: 16 hours by one environmental scientist or senior environmental scientist 
(specialist) = 16 hours 

Field visit to check phenology: 8 hours by one environmental scientist or senior environmental 
scientist (specialist) and one other field helper = 16 hours 

Field visits to collect data: 16 hours by one environmental scientist or senior environmental 
scientist (specialist) and three other field helpers = 64 hours 

In-office data analysis and reporting: 16 hours by one environmental scientist or senior 
environmental scientist (specialist) = 16 hours 

Fall Field Work: 104 hours 

In-office preparations: 16 hours by one environmental scientist or senior environmental scientist 
(specialist) = 16 hours 

Field visits to collect data: 16 hours by one environmental scientist or senior environmental 
scientist (specialist) and three other field helpers = 64 hours 

In-office data analysis and reporting: 8 hours by one environmental scientist or senior 
environmental scientist (specialist), 16 hours by scientific aid = 24 hours 

TOTAL STAFF TIME NEEDED: Approximately 216 hours per year 

7. MANAGEMENT IMPLICATIONS OF POTENTIAL 

RESULTS 
Management Implication #1: If any part of the 80 percent confident interval for our RDM 
estimate for Stone Ridge Ecological Reserve macroplots A or C exceeds 1000 lbs/acre in two 
consecutive years, the grazing intensity shall be increased by increasing the number of grazing 
animals on Stone Ridge Ecological Reserve in the following year. 
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Management Implication #2: If a qualitative assessment of photomonitoring and Butte County 
meadowfoam density indicates that grazing-related disturbances in any year are impacting the 
ability of Butte County meadowfoam to maintain a healthy self-sustaining population at Stone 
Ridge Ecological Reserve, the grazing intensity at Stone Ridge Ecological Reserve Pasture 1 
shall be reduced by decreasing the number of grazing animals on Stone Ridge Ecological 
Reserve Pasture 1 in the following year, or beginning with implementation of the next grazing 
lease. This conclusion may be supported by a statistically significant reduction in the density of 
Butte County meadowfoam in Stone Ridge Ecological Reserve macroplots C and/or D or other 
information. 

Management Implication #3: If a there has been more than six inches of precipitation in 
February of any year as indicated by weather modeling in the vicinity of Stone Ridge Ecological 
Reserve, cows shall be excluded from Pasture 1 as early as possible in March of that same 
year. The gates to Pasture 1 shall remain closed until the ground in Pasture 1 has become 
considerably less saturated, or a majority of Butte County meadowfoam plants have set seed. 

8. REFERENCES 
Arroyo, M.T.K. 1973. A taximetric study of infraspecific variation in autogamous Limnanthes 
floccosa (Limnanthaceae). Brittonia 25:177-191. 

Bartolome, J.W., W. Frost, and N. McDougald. 2006 Residual Dry Matter Management on 
Coastal and Foothill Annual Rangelands in California. Division of Agriculture and Natural 
Resources, California Rangelands Research and Information Center California Guidelines for 
Volume 8092 of Publication (University of California (System). Division of Agriculture and 
Natural Resources)) 

Brown, C.R. and S.K. Jain. 1979. Reproductive system and pattern of genetic variation in two 
Limnanthes species. Theoretical and Applied Genetics 54:181-190. 

Elzinga, C.L., D.W. Salzer, and J. Willoughby. 1998. Measuring and Monitoring Plant 
Populations. BLM Technical Reference 1730-1. U.S. Dept. of the Interior, Bureau of Land 
Management, Denver, CO. 492 pp. 

Hauptli, H., B.D. Webster, and S.Jain. 1978. Variation in nutlet morphology in Limnanthes. 
American Journal of Botany 65:615-624. 

Jain, S.K. 1976. Local dispersal of Limnanthes nutlets: an experiment with artificial vernal pools. 
Canadian Journal of Botany 56:1995-1997. 

Toy, J. and B.C. Willingham. 1966. Effect of temperature on seed germination of ten species 
and varieties of Limnanthes. Economic Botany 20:71-75. 

Toy, J. and B.C. Willingham. 1967. Some studies of secondary dormancy in Limnanthes seed. 
Economic Botany 21:363-366. 

9. DATA SHEET EXAMPLES 
The following pages are examples of field data sheets that may be used or modified for 
monitoring. 



Field Data Sheet

Density of Limnanthes floccosa  ssp. californica  and Limanthes floccosa  ssp floccosa 

Date:

Date Macroplot Segment
Quadrat Distance 

from Origin (m)*
# ssp. californica # ssp. floccossa 

*Quadrat distance from origin (meters) is the distance along the origin edge of the macroplot

Photo monitoring completed?

Quadrat dimensions:                                                    

Field Personnel: 

Position of Macroplot: (GPS coordinates, bearing, corner of origin)

Location: Stone Ridge Ecological Reserve

Macroplot dimensions:                                      

Methods and Notes: 

YES NO



Stone Ridge Ecological Reserve Butte County Meadowfoam Monitoring Project   Date ______________ 
Residual Dry Matter Data Sheet 
 

Field Observers: ____________________________________________________________________________________ 

Site Info: _________________________________  Weather:____________________________________________ 
 

 

 

Macroplot A  

Size: 164 ft. x 

328.1 ft. 

 

 

Plot Notes: _________________________________________________________________________________________ 

__________________________________________________________________________________________________

___________________________________________ 

Macroplot C   

Size: 164 ft. x 

328.1 ft. 

 

 

 

Plot Notes: 

__________________________________________________________________________________________________ 

__________________________________________________________________________________________________

___________________________________________ 

 

Macroplot B  

Size: 82 ft. x 164 ft. 

 

Plot Notes: 

_________________________________________________________________________________________ 

__________________________________________________________________________________________________

___________________________________________ 

Transect 
Start 
(feet) 

X,Y 
Coordinates 

(feet) 

Weight 
of RDM 
(grams) 

X,Y 
Coordinates 

(feet) 

Weight 
of RDM 
(grams) 

X,Y 
Coordinates 

(feet) 

Weight 
of RDM 
(grams) 

X,Y 
Coordinates 

(feet) 

Weight 
of RDM 
(grams) 

A          

B          

C           

D           

E           

F          

G         

H          

Transect 
Start 
(feet) 

X,Y 
Coordinates 

(feet) 

Weight 
of RDM 
(grams) 

X,Y 
Coordinates 

(feet) 

Weight 
of RDM 
(grams) 

X,Y 
Coordinates 

(feet) 

Weight 
of RDM 
(grams) 

X,Y 
Coordinates 

(feet) 

Weight 
of RDM 
(grams) 

A          

B          

C           

D           

E           

F          

G         

H          

Transect 
Start 
(feet) 

X,Y 
Coordinates 

(feet) 

Weight 
of RDM 
(grams) 

X,Y 
Coordinates 

(feet) 

Weight 
of RDM 
(grams) 

A    
 

B    
 

C    
 

D    
 



Photomonitoring Log: Stone Ridge Macroplot A 

Shoot all with a focal length equivalent to 27mm on a full frame camera (e.g. 18mm on a Nikon dx lens 

which is what Jeb uses). All photos should be shot from 5 feet above the ground, or with the tripod 

extended to maximum height. Take a photo of this monitoring sheet before you begin the monitoring 

photos.  

Date of observation:         Camera and Lens:     

Observer(s): __________________________ Focal Length:______ Camera Setting: ____________ 

 

Photo 
point 

From Toward Description/Notes Photo file name in 
camera 

a S Marker E Marker 
(horizon ¼ of the way 
down from top of frame) 

  

b S Marker E Marker  
(~45° angle down 
at ground) 

  

c S Marker N Marker 
(horizon ¼ of the way 
down from top of frame) 

  

d S Marker N Marker  
(~45° angle down 
at ground) 

  

e S Marker W Marker 
(horizon ¼ of the way 
down from top of frame) 

  

f S Marker W Marker  
(~45° angle down 
at ground) 

  

g W Marker S Marker 
(horizon ¼ of the way 
down from top of frame) 

  

h W Marker S Marker  
(~45° angle down 
at ground) 

  

i W Marker E Marker 
(horizon ¼ of the way 
down from top of frame) 

  

j W Marker E Marker  
(~45° angle down 
at ground) 

  



k W Marker N Marker 
(horizon ¼ of the way 
down from top of frame) 

  

l W Marker N Marker  
(~45° angle down 
at ground) 

  

m N Marker W Marker 
(horizon ¼ of the way 
down from top of frame) 

  

n N Marker W Marker  
(~45° angle down 
at ground) 

  

o N Marker S Marker 
(horizon ¼ of the way 
down from top of frame) 

  

p N Marker S Marker  
(~45° angle down 
at ground) 

  

q N Marker E Marker 
(horizon ¼ of the way 
down from top of frame) 

  

r N Marker E Marker  
(~45° angle down 
at ground) 

  

s E Marker N Marker 
(horizon ¼ of the way 
down from top of frame) 

  

t E Marker N Marker  
(~45° angle down 
at ground) 

  

u E Marker W Marker 
(horizon ¼ of the way 
down from top of frame) 

  

v E Marker W Marker  
(~45° angle down 
at ground) 

  

w E Marker S Marker 
(horizon ¼ of the way 
down from top of frame) 

  

x E Marker S Marker  
(~45° angle down 
at ground) 

  

 



Photomonitoring Log: Stone Ridge Macroplot B 

Shoot all with a focal length equivalent to 27mm on a full frame camera (e.g. 18mm on a Nikon dx lens 

which is what Jeb uses). All photos should be shot from 5 feet above the ground, or with the tripod 

extended to maximum height. Take a photo of this monitoring sheet before you begin the monitoring 

photos. 

Date of observation:    Camera and Lens:   

Observer(s): __________________________ Focal Length:______ Camera Setting: ____________ 

 

Photo 
point 

From Toward Description/Notes Photo file name in 
camera 

a SE Marker NE Marker 
(horizon ¼ of the way 
down from top of 
frame) 

  

b SE Marker NE Marker  
(~45° angle 
down at ground) 

  

c SE Marker NW Marker 
(horizon ¼ of the way 
down from top of 
frame) 

  

d SE Marker NW Marker  
(~45° angle 
down at ground) 

  

e SE Marker SW Marker 
(horizon ¼ of the way 
down from top of 
frame) 

  

f SE Marker SW Marker  
(~45° angle 
down at ground) 

  

g SW Marker SE Marker 
(horizon ¼ of the way 
down from top of 
frame) 

  

h SW Marker SE Marker  
(~45° angle 
down at ground) 

  

i SW Marker NE Marker 
(horizon ¼ of the way 
down from top of 
frame) 

  

j SW Marker NE Marker 
(~45° angle 
down at ground) 

  



k SW Marker NW Marker 
(horizon ¼ of the way 
down from top of 
frame) 

  

l SW Marker NW Marker 
(~45° angle 
down at ground) 

  

m NW Marker SW Marker 
(horizon ¼ of the way 
down from top of 
frame) 

  

n NW Marker SW Marker 
(~45° angle 
down at ground) 

  

o NW Marker SE Marker 
(horizon ¼ of the way 
down from top of 
frame) 

  

p NW Marker SE Marker 
(~45° angle 
down at ground) 

  

q NW Marker NE Marker 
(horizon ¼ of the way 
down from top of 
frame) 

  

r NW Marker NE Marker 
(~45° angle 
down at ground) 

  

s NE Marker NW Marker 
(horizon ¼ of the way 
down from top of 
frame) 

  

t NE Marker NW Marker 
(~45° angle 
down at ground) 

  

u NE Marker SW Marker 
(horizon ¼ of the way 
down from top of 
frame) 

  

v NE Marker SW Marker 
(~45° angle 
down at ground) 

  

w NE Marker SE Marker 
(horizon ¼ of the way 
down from top of 
frame) 

  

x NE Marker SE Marker 
(~45° angle 
down at ground) 

  

 



Photomonitoring Log: Stone Ridge Macroplot C 

Shoot all with a focal length equivalent to 27mm on a full frame camera (e.g. 18mm on a Nikon dx lens 

which is what Jeb uses). All photos should be shot from 5 feet above the ground, or with the tripod 

extended to maximum height. Take a photo of this monitoring sheet before you begin the monitoring 

photos. 

Date of observation:    Camera and Lens:   

Observer(s): __________________________ Focal Length:______ Camera Setting: ____________ 

 

Photo 
point 

From Toward Description/Notes Photo file name in 
camera 

a SE Marker NE Marker 
(horizon ¼ of the way 
down from top of 
frame) 

  

b SE Marker NE Marker  
(~45° angle 
down at ground) 

  

c SE Marker NW Marker 
(horizon ¼ of the way 
down from top of 
frame) 

  

d SE Marker NW Marker  
(~45° angle 
down at ground) 

  

e SE Marker SW Marker 
(horizon ¼ of the way 
down from top of 
frame) 

  

f SE Marker SW Marker  
(~45° angle 
down at ground) 

  

g SW Marker SE Marker 
(horizon ¼ of the way 
down from top of 
frame) 

  

h SW Marker SE Marker  
(~45° angle 
down at ground) 

  

i SW Marker NE Marker 
(horizon ¼ of the way 
down from top of 
frame) 

  

j SW Marker NE Marker 
(~45° angle 
down at ground) 

  



k SW Marker NW Marker 
(horizon ¼ of the way 
down from top of 
frame) 

  

l SW Marker NW Marker 
(~45° angle 
down at ground) 

  

m NW Marker SW Marker 
(horizon ¼ of the way 
down from top of 
frame) 

  

n NW Marker SW Marker 
(~45° angle 
down at ground) 

  

o NW Marker SE Marker 
(horizon ¼ of the way 
down from top of 
frame) 

  

p NW Marker SE Marker 
(~45° angle 
down at ground) 

  

q NW Marker NE Marker 
(horizon ¼ of the way 
down from top of 
frame) 

  

r NW Marker NE Marker 
(~45° angle 
down at ground) 

  

s NE Marker NW Marker 
(horizon ¼ of the way 
down from top of 
frame) 

  

t NE Marker NW Marker 
(~45° angle 
down at ground) 

  

u NE Marker SW Marker 
(horizon ¼ of the way 
down from top of 
frame) 

  

v NE Marker SW Marker 
(~45° angle 
down at ground) 

  

w NE Marker SE Marker 
(horizon ¼ of the way 
down from top of 
frame) 

  

x NE Marker SE Marker 
(~45° angle 
down at ground) 

  

 



Photomonitoring Log: Stone Ridge Macroplot D 

Shoot all with a focal length equivalent to 27mm on a full frame camera (e.g. 18mm on a Nikon dx lens 

which is what Jeb uses). All photos should be shot from 5 feet above the ground, or with the tripod 

extended to maximum height. Take a photo of this monitoring sheet before you begin the monitoring 

photos. 

Date of observation:    Camera and Lens:   

Observer(s): __________________________ Focal Length:______ Camera Setting: ____________ 

 

Photo 
point 

From Toward Description/Notes Photo file name in 
camera 

a SE Marker NE Marker 
(horizon ¼ of the way 
down from top of 
frame) 

  

b SE Marker NE Marker  
(~45° angle 
down at ground) 

  

c SE Marker NW Marker 
(horizon ¼ of the way 
down from top of 
frame) 

  

d SE Marker NW Marker  
(~45° angle 
down at ground) 

  

e SE Marker SW Marker 
(horizon ¼ of the way 
down from top of 
frame) 

  

f SE Marker SW Marker  
(~45° angle 
down at ground) 

  

g SW Marker SE Marker 
(horizon ¼ of the way 
down from top of 
frame) 

  

h SW Marker SE Marker  
(~45° angle 
down at ground) 

  

i SW Marker NE Marker 
(horizon ¼ of the way 
down from top of 
frame) 

  

j SW Marker NE Marker 
(~45° angle 
down at ground) 

  



k SW Marker NW Marker 
(horizon ¼ of the way 
down from top of 
frame) 

  

l SW Marker NW Marker 
(~45° angle 
down at ground) 

  

m NW Marker SW Marker 
(horizon ¼ of the way 
down from top of 
frame) 

  

n NW Marker SW Marker 
(~45° angle 
down at ground) 

  

o NW Marker SE Marker 
(horizon ¼ of the way 
down from top of 
frame) 

  

p NW Marker SE Marker 
(~45° angle 
down at ground) 

  

q NW Marker NE Marker 
(horizon ¼ of the way 
down from top of 
frame) 

  

r NW Marker NE Marker 
(~45° angle 
down at ground) 

  

s NE Marker NW Marker 
(horizon ¼ of the way 
down from top of 
frame) 

  

t NE Marker NW Marker 
(~45° angle 
down at ground) 

  

u NE Marker SW Marker 
(horizon ¼ of the way 
down from top of 
frame) 

  

v NE Marker SW Marker 
(~45° angle 
down at ground) 

  

w NE Marker SE Marker 
(horizon ¼ of the way 
down from top of 
frame) 

  

x NE Marker SE Marker 
(~45° angle 
down at ground) 

  

 



California Department of Fish and Wildlife Stone Ridge Ecological Reserve Qualitative Monitoring 

Date: 

 

Field Personnel: 

 

Location(s) Visited: 

 

 

 

Describe the phenological condition of vegetation, soil saturation and soil disturbance 

 

 

 

 

 

 

 

Describe any particularly abundant or notable plants or wildlife observed: 

 

 

 

 

 

 

 

Describe Visible Threats and Disturbances: 

 

 

 

 

 

 

Describe Weed Infestations: 

 

 

 

 

 

 

Evidence of Livestock Use and Number of Grazing Animals Observed: 

 

 

Photographs taken: 

 

 

Recommendations: 
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1. INTRODUCTION  
This document summarizes the 2015-2017 monitoring results from implementation of the 2017 
Stone Ridge Ecological Reserve Butte County Meadowfoam Monitoring Plan (Monitoring Plan). 
The Monitoring Plan is included as Part 1 of this report and includes detailed instructions on 
how to implement the monitoring protocol for Limnanthes floccosa ssp. californica (Butte County 
meadowfoam) at the California Department of Fish and Wildlife (CDFW) Stone Ridge Ecological 
Reserve (Reserve). The purpose of the Monitoring Plan is to facilitate adaptive management of 
the populations of Butte County meadowfoam at the Reserve. Implementation of the Monitoring 
Plan is expected to continue into 2021 or later. This document includes an interpretation of 
results, an assessment of the monitoring project, and management recommendations. The 
results and recommendations in this document are a critical step in the adaptive management 
process. 

2. SUMMARY OF RESULTS 
This document reports on the result of the following monitoring components: 

1. Monitoring spring density of the target species Butte County meadowfoam, and a closely 
related possible indicator species Limnanthes floccosa ssp. floccosa (woolly 
meadowfoam); 

2. Monitoring residual dry matter (RDM) in the fall; 
3. Taking monitoring photographs; and 
4. A qualitative description of the grazing that took place. 

In addition, precipitation information generated using a PRISM climate model is presented, and 
general observations of other rare plants on the Reserve are reported.  

2.1. SPRING DENSITY MONITORING 

The Locations of Macroplots A-D are presented in Figures 2 and 3 of the Monitoring Plan (See 
Part 1 of this Report).  

Butte County meadowfoam and/or woolly meadowfoam were present in each monitoring 
macroplot every year from 2015 to 2017. Butte County meadowfoam and woolly meadowfoam 
also occur elsewhere on the Reserve, outside of the macroplots, and these areas were not 
monitored. 

Butte County Meadowfoam 

A small number of Butte County meadowfoam plants (64) were observed in Macroplot A in 2016 
and Macroplots C and D contained robust populations of Butte County meadowfoam every year 
from 2015 to 2017 (Figure 1). 

Macroplot C is a relatively large macroplot that contains Butte County meadowfoam plants 
distributed through a network of swales. The number of Butte County meadowfoam plants in 
Macroplot C in 2015 was not statistically different than the number observed in 2016 (1,090). 
The number of Butte County meadowfoam plants in Macroplot C was, however, significantly 
lower in 2017 than in both 2015 and 2016.  

  



 

Figure 1 
Results of Limnanthes floccosa ssp. californica Density Monitoring 

California Department of Fish and Wildlife  Stone Ridge Ecological Reserve Butte County Meadowfoam Monitoring 
Results and Discussion 2015-2017 
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Macroplot D is a relatively small macroplot located at a swale with a particularly dense 
population of Butte County meadowfoam. 581 Butte County meadowfoam plants were observed 
in Macroplot D in 2015, 1,095 were observed in 2016, and 706 were observed in 2017. 

Woolly Meadowfoam 

Macroplots A and B contained robust populations of woolly meadowfoam every year from 2015 
to 2017, and a small number of woolly meadowfoam plants were also counted in Macroplot C in 
2016 (45) and 2017 (6) (Figure 2). 

Macroplot A is a relatively large macroplot with woolly meadowfoam plants distributed 
throughout the Macroplot. A statistical difference in the number of woolly meadowfoam plants 
was not detected in Macroplot A between 2015 and 2016; however, there were significantly 
fewer plants in 2017.  

Macroplot B is one quarter the area of Macroplot A, but similarly contains woolly meadowfoam 
plants distributed throughout the macroplot. No statistically significant differences in the number 
of woolly meadowfoam plants were detected between any of the years in Macroplot B.  

2.2. ANNUAL MONITORING FOR ADAPTIVE MANAGEMENT OF 

RESIDUAL DRY MATTER 

The weight of residual dry matter (RDM) was monitored within several macroplots from 2015 to 
2017. The results of RDM monitoring are presented in Figure 3. In 2014, prior to implementation 
of the Monitoring Plan, the Reserve manager collected three RDM samples from the Reserve 
near Cohasset Road, and averaged the three samples to arrive at an estimate of 1472 pounds 
per acre of RDM. In Macroplot A there was a statistically significant decline in RDM from 2015 
to 2016, and another statistically significant decline between 2016 and 2017. There is no data 
from Macroplot B in 2016, but RDM was significantly lower in 2017 than it was in 2015. There 
was not a statistically significant decline in RDM in Macroplot C from 2015 to 2016, but there 
was a statistically significant decline in RDM from both 2015 and 2016 to 2017. RDM samples 
have not been collected regularly from Macroplot D due to the relatively small size of the 
macroplot, and its position over a swale.   

Based on the data available, there appears to have been a clear negative trend in the amount of 
fall RDM on the Reserve from 2014 to 2017.  

2.3. ANNUAL PHOTOMONITORING FOR ADAPTIVE MANAGEMENT 

Ninty-six monitoring photo positions were used at the reserve, with 24 monitoring photographs 
taken whenever density or RDM data was collected at one of the four macroplots. Some of the 
monitoring photos from 2015-2017 at photo positions Aa, Aq, Bc, Cu and Di are presented in 
Figures 4 through 9. 

2.4. DOCUMENTATION OF GRAZING 

There is limited information about the grazing practices at the Reserve prior to implementation 
of the Monitoring Plan. The Reserve had been grazed for over 40 years by the adjacent 
landowner and historical grazing operator Mr. Jon Bechtal. Mr. Bechtel grazed 300-400 head of 
cattle on the Reserve and his land for 30-40 years until 2005 when CDFW purchased the 
Reserve. Mr. Bechtal continued to be the grazing operator on the site through the spring 2013 
grazing season. During this time, the Reserve was grazed by approximately 85 cows from  



Figure 2 
Results of Limnanthes floccosa ssp. floccosa Density Monitoring 
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Figure 3 
Results of Fall Residual Dry Matter Monitoring 
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Figure 4 
Photopoint Aa 2015-2017 (Spring) 
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Figure 5 
Photopoint Aq 2015-2017 (Fall) 
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Figure 6 
Photopoint Aq 2015-2017 (Spring) 
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Figure 7 
Photopoint Bc 2015-2017 (Spring) 
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Figure 8 
Photopoint Cu 2015-2017 (Spring) 
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Figure 9 
Photopoint Di 2015-2017 (Spring) 
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December through May 31. The Reserve was not grazed in the spring of 2014 due to the 
change in grazing operator. As a result, the Reserve manager, Henry Lomeli, observed that 
there was a particularly high amount of RDM on the Reserve in the Fall of 2014, higher than any 
of the other years he had observed the property (since approximately 2000).  

CDFW established a land use agreement with a different grazing operator, Mr. Scott Larrabee, 
for the removal of vegetation from the Reserve, and grazing resumed for the spring 2015 
grazing season. The agreement allows cattle to be on the Reserve from December 1 through 
May 31 (6 months). Grazing is limited to no more than 360 animal unit months (AUMs) per year 
(60 AUMs/month multiplied by 6 months = 360 AUMs/year). Weaned calves and light steers 
between 350 -600 pound weight class are each counted as 0.7 animal unit and bulls, cows, 
cows with calves, and steers over 600 pounds are counted as 1.0 animal unit. The current land 
use agreement expires on May 31, 2018.  

There are three pastures on the Reserve (Figure 10). Pasture 1 is adjacent to Cohasset Road 
and the access gate, and all Butte County meadowfoam observed on the Reserve by CDFW 
staff since 2015 has been in Pasture 1. Pasture 2 is the largest pasture and the only pasture 
with permanent access to water from Mud Creek. Pasture 3 is the smallest and most remote 
pasture, with access to a seasonal stream.  

2014/2015 Grazing Season: An e-mail from Mr. Larrabee reported that 55 cow/calf pairs were 
added to the Reserve on December 14, 2014, and an additional 25 cow/calf pairs were added 
on February 2, 2015. The pastures were rotated approximately every two weeks, however the 
largest pasture, which has access to Mud Creek, was always accessible because it is the only 
pasture with reliable water. No supplemental water was provided. Animals were allowed to 
graze freely and were reported to spread out over the Reserve well. The 80 cow/calf pairs were 
removed on April 26, 2015. Mr. Larrabee also reported that Mr. Betchtal constantly complained 
to him about the use of the gravel road on the Reserve.  

2015/2016 Grazing Season: Cows were observed on the Reserve but not counted. Due to the 
low amount of water on the Reserve, water was trucked in to the Reserve for the cows, and 
some cows were sequestered in the pasture near Cohasset Road that supports Butte County 
meadowfoam to increase the grazing pressure in this area. Two 600 gallon water tanks had to 
be used and water was hauled in every day for some time.  

2016/2017 Grazing Season: After noticing an unusually high number of cows on the Reserve, 
CDFW staff completed a rough count of animals while walking from the access gate to the 
northern part of the Reserve, and then south and back to the access gate. On March 3, 2017, 
CDFW staff counted approximately 130 animals (cows, calves, and at least 2 large males with 
horns) on the reserve, trying as best as possible not to double count. CDFW staff did not walk 
the entire Reserve, and therefore this count likely underestimates the total number of animals 
that were present on the Reserve. The adjacent landowner, Mr. Bechtal, reportedly released 
some of his cows on the Reserve as well, without permission. CDFW staff observed the 
Reserve to be much more disturbed and trampled from muddy hoofprints in March of 2017 than 
in the previous two years (see Figures 4, 6, 7, 8, and 9). The high number of animals present 
and muddy ground from high rainfall likely contributed to the site disturbance observed.  

2.5. PRECIPITATION 

Precipitation information generated using a PRISM climate model is presented in Figure 11 
(PRISM 2017). Butte County meadowfoam germinates in the Fall after the onset of winter 
precipitation, and blooms in March and April, therefore September to March precipitation is  



Figure 10 
Grazing Pastures at Stone Ridge Ecological Reserve 
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Figure 11 
Rainfall at Stone Ridge Ecological Reserve 2015-2017 
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assumed to be an important factor for Butte County meadowfoam growth and survival. Overall, 
there was a clear positive trend in growing season precipitation from 2015 to 2017. January and 
March of 2015 were very dry, with little rainfall. February of 2016 also had very little rainfall. The 
winter of 2016-2017 was very wet in every month of the growing season.  

2.6. OTHER OBSERVATIONS 

In addition to Butte County meadowfoam and woolly meadowfoam, several other rare plants 
were observed on the Reserve.  

Adobe lily (Fritillaria pluriflora) has a California Rare Plant Rank of 1B.2 and California Natural 
Diversity Database element occurrence number 118 occurs on the Reserve. Adobe lily was 
observed by CDFW staff on the Reserve in 2015, 2016, and 2017, but no quantitative estimates 
of the population were made. On February 24, 2017 the Adobe lily population was visually 
estimated to consist of between 100-1000 individuals with only approximately 5 percent of them 
flowering. Many of the individuals were heavily grazed with only a few inches of leaves left and 
no flowering stalk remaining. The ground was very pocketed by hoof prints and the impressions 
were pooled with water that was not infiltrating. The adobe lily population was noticeably 
impacted by trampling. The adobe lily population is in Pasture 2. 

Ahart’s paronychia (Paronychia ahartii) has a California Rare Plant Rank of 1B.1 and California 
Natural Diversity Database element occurrence number 62 occurs on the Reserve. The Ahart’s 
paronychia population on the Reserve was observed by CDFW staff in 2015 and 2016, but no 
quantitative estimates of the population were made.  

Depauperate milk-vetch (Astragalus pauperculus) has a California Rare Plant Rank of 4.3 and 
occurs on the Reserve. A small population was discovered at approximately 39 48’50.32”, -121 
50’05.05” (WGS84) on March 7, 2016.  

3. INTERPRETATION OF RESULTS 
With only three years of monitoring data, it is difficult to make strong conclusions; however, 
because growth and reproduction of a considerable number of Butte County meadowfoam and 
woolly meadowfoam plants has occurred within monitoring macroplots every year, the 
populations within the monitoring macroplots may be relatively stable. If the conditions within 
monitoring macroplots are representative of the conditions for meadowfoam populations on the 
Reserve as a whole, as was intended with the design of the Monitoring Plan, the populations of 
both Butte County meadowfoam and woolly meadowfoam may be similarly stable on the 
Reserve.  

2016 was the “best” year for Butte County meadowfoam, with the highest number of plants in 
monitoring macroplots, and 2017 appears to have been the “worst” of the three monitoring years 
for Butte County meadowfoam, with 2015 somewhere in between.  

The number of Butte County meadowfoam plants in 2015 may have been lower than the 
numbers in 2016 due to very low precipitation levels in January and March of 2015.  

The high number of Butte County meadowfoam plants in 2016 may have been due to the 
relatively low impacts from grazing and trampling in the 2016 growing season due to relatively 
low water availability in the pasture supporting the Butte County meadowfoam population, but 
still with sufficient rainfall in January and March to support growth and survival of plants.  
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A plausible explanation for the lower number of Butte County meadowfoam plants in 2017 is the 
increased impacts from grazing and trampling in 2017 due to an increase in the number on 
animals on the reserve, combined with very wet winter and spring conditions that left the ground 
susceptible to more hoof disturbance from cows. Another explanation could be that years with 
high precipitation in every month of the growing season and the resulting ground conditions are 
less suitable for Butte County meadowfoam growth and survival than years with less 
precipitation. 

Woolly meadowfoam monitoring results are less precise than the monitoring results for Butte 
County meadowfoam due to the reliance on sampling. The only statistically significant difference 
detected for woolly meadowfoam populations was a lower number of plants in Macroplot A in 
2017 compared with the number of plants in 2015 and 2016, which contributes to the theory that 
plant populations were likely impacted by increased impacts from grazing and trampling in 2017. 
Plant density monitoring results for Macroplot B were not very insightful because no statistically 
significant differences between monitoring years were detected. Macroplot B is the only 
macroplot located within Pasture 2, and it is the only macroplot located near a pasture gate. 
Because Macroplot B is located in an area that cows are funneled through to move between 
Pastures 1 and 2, it is likely subject to unique grazing pressures that depend on the number of 
cows that use the gate.  

March monitoring photographs from 2015 and 2016 are generally similar with regard to the 
amount of green annual vegetation on the landscape; however, monitoring photos from March 
2016 generally show many more plants in bloom, and the photos are therefore more colorful 
than the same photos from 2015. March monitoring photographs from 2017 showed the ground 
on the Reserve to be considerably disturbed by cow hoof prints.  

Residual dry matter appears to have reduced every year since 2014. This reduction could be 
due to seasonal weather patterns that are less favorable for the accumulation of RDM (i.e. 
drought), trampling of vegetation due to saturated soils in the winter and spring of 2017, and 
removal of more RDM as a result of increased grazing pressures in 2017.  

Considering the information observed during the 2015-2017 monitoring period, the factors that 
are most likely to be negatively affecting the Butte County meadowfoam population on the 
Reserve are:  

 Soil disturbance from cows when the ground is saturated; 

 Prolonged inundation of habitat during the growing season due to record rainfall in 
2017; 

 Low precipitation levels in January and March as observed in 2015.  

Of these factors listed above, the only factor that CDFW has some control over is the level of 
soil disturbance from cows when the ground is saturated.  

4. ASSESSMENT OF THE MONITORING PROJECT 
The monitoring project has been largely successful. Our methods have resulted in some 
insightful data, and by monitoring the site in 2017 we were able to detect the high levels of site 
disturbance that resulted from the wet winter and spring conditions combined with additional 
cows released onto the Reserve by Mr. Bechtel. All Butte County meadowfoam plants in 
Macroplots C and D were counted in 2016 and 2017 and therefore the monitoring data for Butte 
County meadowfoam is highly accurate. The monitoring data for woolly meadowfoam is less 
accurate due to a reliance on sampling, but because woolly meadowfoam is not the primary 



19 

California Department of Fish and Wildlife   Stone Ridge Ecological Reserve Butte County Meadowfoam Monitoring 
  Results and Discussion 2015-2017 

focus of the monitoring project, the accuracy of the woolly meadowfoam density data may be 
sufficient.  

One drawback to the monitoring project so far has been the commitment of staff time required to 
complete it. The monitoring requires approximately 216 staff hours per year to implement. 
Despite the staff time commitment, the plan continues to be a valuable approach to adaptive 
management of the Reserve. If the Monitoring Plan were to be scaled back, a reasonable 
approach would be to discontinue monitoring the density of meadowfoam in Macroplots A 
and/or B, or discontinue monitoring of RDM at Macroplot B. Due to the position of Macroplot A 
away from any gates or fences, its large area, and the absence of any cattle trails going through 
it, Macroplot A is likely the most representative macroplot for RDM within all of Pasture 1. 
Pasture 1 contains all Butte County meadowfoam plants that were observed on the Reserve by 
CDFW staff during the 2015-2017 monitoring period, and is therefore the most important 
pasture for Butte County meadowfoam on the Reserve. CDFW should continue monitoring RDM 
in Macroplot A, even if the Monitoring Plan were to be scaled back.  

Additionally, attempts to precisely align monitoring photos has been difficult. Precise alignment 
of monitoring photos is important because it allows direct comparison of specific areas of the 
ground in the photograph, and it may be very difficult to determine which areas of the ground 
are the same if two monitoring photos are even slightly misaligned. Differences in perspective 
resulting from photographs taken with different cameras, from slightly different positions and in 
slightly different directions can be very distracting, and may require careful correction with photo 
editing software such as Photoshop before insightful comparisons become possible. Because 
correcting the differences in perspective requires photo editing expertise and a considerable 
time commitment, every effort should be made to standardize monitoring photos as much as 
possible in the field.  

5. MANAGEMENT RECOMMENDATIONS 
The management objectives and management implications identified in the Monitoring Plan are 
repeated below, with a discussion of whether the management implications should be triggered 
based on the monitoring results. Additional management recommendations for the project are 
also included. 

5.1. MANAGEMENT OBJECTIVE #1 

Prevent the RDM of all Stone Ridge Ecological Reserve macroplots that are known to contain 
Butte County meadowfoam from exceeding 1000 lbs/acre in two consecutive years.  

Management Implication from Monitoring Plan: If any part of the 80 percent confident 
interval for our RDM estimate for Stone Ridge Ecological Reserve macroplots A or C exceeds 
1000 lbs/acre in two consecutive years, the grazing intensity shall be increased by increasing 
the number of grazing animals on Stone Ridge Ecological Reserve in the following year. 

Recommendation: RDM has been lower than 1,000 lbs/acre for every year of monitoring in all 
macroplots monitored. An increase in grazing intensity is not necessary.  

5.2. MANAGEMENT OBJECTIVE #2  

Prevent grazing-related disturbances from impacting the ability of Butte County meadowfoam 
and other rare plants to maintain healthy self-sustaining populations at Stone Ridge Ecological 
Reserve. 
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Management Implication from Monitoring Plan: If a qualitative assessment of 
photomonitoring and Butte County meadowfoam density indicates that grazing-related 
disturbances in any year are impacting the ability of Butte County meadowfoam to maintain a 
healthy self-sustaining population at Stone Ridge Ecological Reserve, the grazing intensity at 
Stone Ridge Ecological Reserve Pasture 1 shall be reduced by decreasing the number of 
grazing animals on Stone Ridge Ecological Reserve Pasture 1 in the following year, or 
beginning with implementation of the next grazing lease. This conclusion may be supported by a 
statistically significant reduction in the density of Butte County meadowfoam in Stone Ridge 
Ecological Reserve macroplots C and/or D or other information. 

Recommendation: Grazing-related disturbances were high in 2017, and there was a 
statistically significant reduction in the number of Butte County meadowfoam plants in 2017. 
Despite the grazing-related disturbances, there was still a considerable number of Butte County 
meadowfoam plants in macroplots C and D in 2017. If the grazing related disturbances of 2017 
continued, this could be an impact to the ability of Butte County meadowfoam to maintain a 
healthy self-sustaining population at the Reserve; however, it is unlikely that the impacts of 2017 
will be a common occurrence. 2017 was an unusually wet year, and it is unlikely that similarly 
wet years will be a common occurrence. Nevertheless, it may be appropriate for CDFW to 
restrict cow access to Pasture 1 in some way when wet years do occur (see additional 
Management implication suggested below).  

Furthermore, because CDFW was alerted to the additional cows on the property in 2017, CDFW 
will also be more careful about the number of cows grazing the property in the future. Based on 
the monitoring data collected from 2015 to 2017, the level of grazing used in 2015 and 2016 
appears to be compatible with maintaining a population of Butte County meadowfoam on the 
Reserve, and no change in grazing intensity from what was used in in the 2014-2015 and 2015-
2016 grazing seasons appears to be needed at this time to avoid impacting the ability of Butte 
County meadowfoam to maintain a healthy self-sustaining population.  

The current a land use agreement to graze cows on the Reserve for vegetation control is 
scheduled to expire at the end of the 2017-2018 grazing season, and the operator, Mr. Scott 
Larrabee has indicated that he might not graze the property for the final, 2017-2018 grazing 
season. Butte County meadowfoam plants tends to occur in the deeper parts of rocky swales, in 
areas that experience less competition from invasive Mediterranean grasses. Mediterranean 
grasses are therefore less likely to produce thatch in areas where Butte County meadowfoam is 
found, and the presence of a greater biomass of Mediterranean grasses on the Reserve in the 
absence of grazing for a year, would likely only have a small to negligible negative impact on 
the Butte County meadowfoam population from increased thatch and competition. A complete 
rest from grazing, and from grazing-related impacts for a season may therefore be beneficial for 
the Butte County meadowfoam population. Furthermore, if cows do not graze the property 
during the 2017-2018 grazing season, it will be an opportunity to observe how the amount of 
RDM and the populations of Butte County meadowfoam and woolly meadowfoam respond to a 
complete rest from grazing for a season.  

Management Implication Proposed for Addition to the Monitoring Plan: If there has been 
more than six inches of precipitation in February of any year as indicated by weather modeling 
in the vicinity of Stone Ridge Ecological Reserve, cows shall be excluded from Pasture 1 as 
early as possible in March of that same year. The gates to Pasture 1 shall remain closed until 
the ground in Pasture 1 has become considerably less saturated, or a majority of Butte County 
meadowfoam plants have set seed. 
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5.3. OTHER RECOMMENDATIONS 

CDFW should build a barbed wire fence around as much of the adobe lily population on the 
Reserve as possible, and implement a simple photomonitoring plan in the area using fenceposts 
as the locations to take monitoring photos from.  

CDFW should place a field marker near the Ahart’s paronychia population and implement a 
simple photomonitoring plan in the area using the field marker as the location for monitoring 
photos.  

CDFW should map the extent of the Butte County meadowfoam population on the Reserve 
within the next three years, and should prioritize this mapping if a particularly high number of 
Butte County meadowfoam plants are observed in a year. The current CNDDB polygon of the 
Butte County meadowfoam population is quite a bit larger than the actual extent of the 
population as observed by CDFW in 2015, 2016 and 2017.  

CDFW should include a requirement in the next vegetation management agreement for the 
Reserve that the grazing manager provide a simple report to CDFW at the end of the grazing 
season. The report should provide a brief summary of the grazing that took place during the 
year, and should include the following information:  

 The actual number and size classes of animals that were present on the site.  

 The dates that animals were actually added to and removed from the Reserve, including 
dates for any animals that were added late or removed early. 

 The dates that pasture gates were opened and closed and the purposes for opening and 
closing them.  

 The dates that supplemental water was brought to the site (if any), and the locations 
where it was placed.  

 The dates of any efforts to herd animals to specific portions of the site, the locations 
where animals were herded from and herded to, and the reason for herding them.   

 Whether any unauthorized grazing or other unauthorized activity has taken place on the 
Reserve. 

 Any other information on grazing-related activities that took place.  

CDFW should take note of the number of livestock on the Reserve during monitoring visits, and 
ensure that livestock are not released onto the Reserve without permission.  
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Department of Fish and Game Stone Ridge Ecological Reserve City of Chico, Butte County

This worksheet was updated to current taxonomy on 5/11/2015 by Jill Spear, Native Plant Program. Minor updates in 2016 and 2017.

FAMILY GENUS SPECIES var/ssp A.K.A. DATE

N

A

T COMMENTS

Agavaceae Chlorogalum angustifolium Narrow-Leaved Soap-Plant 3/4/2007 Y

Alliaceae Allium amplectens Clasping Onion 3/17/2007 Y
Amaranthaceae Amaranthus albus Tumbleweed 6/9/2007 N

Anacardiaceae Toxicodendron diversilobum Western Poison-Oak 3/28/2007 Y

Apiaceae Anthriscus caucalis Bur-Chervil 4/29/2007 N

Apiaceae Daucus pusillus Rattlesnake-Weed 5/5/2007 Y

Apiaceae Eryngium castrense Coyote-Thistle 3/4/2007 Y

Apiaceae Lomatium utriculatum Bladder Lomatium 3/4/2007 Y

Apiaceae Sanicula bipinnata Poison Sanicule 3/4/2007 Y

Apiaceae Sanicula bipinnatifida Purple Sanicle 3/4/2007 Y

Apiaceae Torilis nodosa Knotted Hedge-Parsley 4/29/2007 N

Apocynaceae Apocynum cannabinum Indian-Hemp 4/15/2007 Y adjacent Mud Creek

Apocynaceae Asclepias eriocarpa Indian Milkweed 3/28/2007 Y

Apocynaceae Asclepias fascicularis Narrow-Leaved Milkweed 4/15/2007 Y adjacent Mud Creek

Aristolochiaceae Aristolochia californica California Pipevine 3/28/2007 Y one patch each observed along Sheep Hollow Creek and Mud Creek

Asteraceae Achyrachaena mollis Blow-Wives 3/24/2007 Y

Asteraceae Artemisia douglasiana Mugwort 4/15/2007 Y adjacent Mud Creek

Asteraceae Baccharis salicifolia ssp. salicifolia Mule's-Fat 4/15/2007 Y adjacent Mud Creek

Asteraceae Bidens frondosa Sticktight 6/9/2007 Y adjacent Mud Creek

Asteraceae Blennosperma nanum var. nanum Yellow-Carpet 3/4/2007 Y
Asteraceae Brickellia californica California Brickellia 3/28/2007 Y in and about a dry seasonal streambed in the se corner of the property

Asteraceae Centaurea melitensis Tocalote 5/5/2007 N
Asteraceae Centaurea solstitialis Yellow Star-Thistle 3/17/2007 N NOXIOUS WEED, C List

Asteraceae Centromadia fitchii Fitch's Spikeweed 6/9/2007 Y

Asteraceae Eriophyllum lanatum var. grandiflorum Large-Flowered Woolly-Sunflower 3/28/2007 Y
Asteraceae Gnaphalium palustre Western Marsh Cudweed 6/9/2007 Y adjacent Mud Creek
Asteraceae Grindelia camporum Foothill Gumplant 5/5/2007 Y drainage ditch adjacent Cohasset Hwy and S.R.Ranch

Asteraceae Hedypnois rhagadioloides Hedypnois 4/29/2007 N

Asteraceae Helianthus bolanderi Bolander's Sunflower 6/10/2007 Y adjacent Mud Creek

Asteraceae Hesperevax acaulis var. acaulis Dwarf Evax 3/17/2007 Y

Asteraceae Hesperevax caulescens Hogwallow Evax 4/15/2007 Y CNPS List 4

Asteraceae Hypochaeris glabra Smooth Cat's-Ear 3/25/2007 N

Asteraceae Lactuca serriola Prickly Lettuce 6/9/2007 N

Asteraceae Lasthenia californica California Goldfields 3/17/2007 Y

Asteraceae Lasthenia fremontii Fremont's Goldfields 3/24/2007 Y

Asteraceae Lasthenia gracilis Common Goldfields 3/3/2017 Y

Asteraceae Layia fremontii Fremont's Tidytips 3/17/2007 Y
Asteraceae Logfia gallica Narrow-Leaved Filago 3/31/2007 N

Asteraceae Madia elegans Spring Madia 5/5/2007 Y

Asteraceae Matricaria discoidea Common Pineapple-Weed 3/25/2007 Y

Asteraceae Micropus californicus var. californicus Slender Cottongrass 3/17/2007 Y

Asteraceae Psilocarphus oregonus Oregon Woolly-Marbles 3/25/2007 Y

AKA= Oswald, V. 2002

DATE= Observation

NATive: Y=yes; N=No
2/20/2018

1 of 7



Department of Fish and Game Stone Ridge Ecological Reserve City of Chico, Butte County

FAMILY GENUS SPECIES var/ssp A.K.A. DATE

N

A

T COMMENTS

Asteraceae Pseudognaphalium luteoalbum Weedy Cudweed 6/9/2007 N adjacent Mud Creek
Asteraceae Microseris acuminata Sierra Foothill Microseris 3/24/2007 Y
Asteraceae Microseris douglasii ssp. douglasii Douglas' Microseris 4/15/2007 Y
Asteraceae Senecio vulgaris Old-Man-In-The-Spring 3/4/2007 N  
Asteraceae Silybum marianum Milk-Thistle 4/15/2007 N adjacent Mud Creek
Asteraceae Sonchus oleraceus Common Sow-Thistle 4/15/2007 N
Asteraceae Taraxacum officinale Common Dandelion 4/29/2007 N
Asteraceae Xanthium strumarium Cocklebur 4/15/2007 Y adjacent Mud Creek

Boraginaceae Amsinckia intermedia Common Fiddleneck 3/17/2007 Y
Boraginaceae Amsinckia lycopsoides Bugloss fiddleneck 4/29/2007 Y

Boraginaceae Cryptantha flaccida Weak-Stemmed Crytantha 5/5/2007 Y

Boraginaceae Cryptantha intermedia Common Crytantha 5/5/2007 Y

Boraginaceae Nemophila pedunculata Meadow Nemopila 3/4/2007 Y

Boraginaceae Pectocarya pusilla Little Pectocarya 3/17/2007 Y

Boraginaceae Phacelia egena Rock Phacelia 3/28/2007 Y
Boraginaceae Plagiobothrys austiniae Austin's Popcorn-Flower 3/17/2007 Y
Boraginaceae Plagiobothrys canescens Valley Popcorn-Flower 3/28/2007 Y
Boraginaceae Plagiobothrys greenei Greene's Popcorn-Flower 3/17/2007 Y
Boraginaceae Plagiobothrys fulvus var. campestris Fulvous Popcorn-Flower 3/17/2007 Y
Boraginaceae Plagiobothrys nothofulvus Common Popcorn-Flower 3/28/2007 Y
Boraginaceae Plagiobothrys scriptus Scribe's Popcorn-Flower 3/4/2007 Y
Boraginaceae Plagiobothrys stipitatus var. micranthus Small-Flowered Stalked Popcorn- 4/11/2007 Y
Brassiaceae Athysanus pusillus Petty Athysanus 3/4/2007 Y
Brassiaceae Capsella bursa-pastoris Shepherd's Purse 3/20/2007 N
Brassiaceae Cardamine oligosperma Western Bittercress 3/31/2007 Y
Brassicaceae Draba verna Spring Draba 2/25/2016 Y collected
Brassiaceae Lepidium nitidum var. nitidum Shining Pepper-Grass 3/17/2007 Y
Brassiaceae Lepidium strictum Upright Pepper-Grass 4/5/2007 N
Brassiaceae Nasturtium officinale Watercress 4/15/2007 Y Mud Creek
Brassiaceae Sisymbrium officinale Hedge-Mustard 4/29/2007 N

Brassiaceae Thysanocarpus curvipes var. curvipes Clasping-Leaved Fringepod 3/17/2007 Y

Brassiaceae Thysanocarpus radians Spokepod 3/17/2007 Y

Campanulaceae Githopsis pulchella ssp. campestris Large-Flowered Bluecup 4/29/2007 Y graveled soil of a seasonal streambed

Campanulaceae Heterocodon rariflorum Heterocodon 3/28/2007 Y

Caprifoliaceae Lonicera interrupta Chaparral Honeysuckle 3/28/2007 Y  thinly scattered plants 
Caryophyllaceae Cerastium fontanum ssp. vulgare Common Mouse-Eared Chickweed 3/27/2007 N

Caryophyllaceae Cerastium glomeratum Sticky Mouse-Eared Chickweed 3/25/2007 N

Caryophyllaceae Minuartia californica California Sandwort 3/17/2007 Y

Caryophyllaceae Paronychia ahartii Ahart's Nailwort 3/25/2007 Y CNPS List 1B, 2nd known Butte County population

Caryophyllaceae Petrorhagia dubia Grass-Pink 3/25/2007 N

Caryophyllaceae Sagina decumbens ssp. occidentalis Western Pearlwort 4/29/2007 Y adjacent Mud Creek

Caryophyllaceae Scleranthus annuus ssp. annuus Knawel 4/15/2007 N

Caryophyllaceae Silene gallica Windmill-Pink 4/15/2007 N adjacent Mud Creek

Caryophyllaceae Spergularia rubra Ruby Sandspurry 4/15/2007 N adjacent Mud Creek

AKA= Oswald, V. 2002

DATE= Observation

NATive: Y=yes; N=No
2/20/2018
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FAMILY GENUS SPECIES var/ssp A.K.A. DATE

N

A

T COMMENTS

Caryophyllaceae Stellaria media Common Chickweed 3/17/2007 N

Caryophyllaceae Stellaria nitens Shining Chickweed 2/24/2017 Y

Caryophyllaceae Stellaria pallida Pallid Starwort 3/20/2007 N

Caryophyllaceae Velezia rigida Velezia 5/5/2007 N

Convolvulaceae Convolvulus arvensis Bindweed 4/29/2007 N

Crassulaceae Crassula connata Pigmyweed 3/4/2007 Y

Crassulaceae Crassula tillaea Mossy Pigmyweed 3/4/2007 Y

Crassulaceae Sedella pumila Dwarf-Stonecrop 3/4/2007 Y

Cyperaceae Cyperus squarrosus Awned Cyperus 6/10/2007 Y adjacent Mud Creek

Cyperaceae Cyperus eragrostis Tall Cyperus 4/29/2007 Y adjacent Mud Creek

Cyperaceae Eleocharis macrostachya Pale Spike-Rush 6/10/2007 Y adjacent Mud Creek

Cyperaceae Schoenoplectus pungens Common Threesquare 4/15/2007 Y wet edge of Mud Creek

Ericaceae Arctostaphylos manzanita ssp. manzanita Big Manzanita 3/31/2007 Y only one medium sized plant observed to date

Euphorbiaceae Croton setiger Turkey-Mullein 3/17/2007 Y

Euphorbiaceae Euphorbia ocellata ssp. ocellata Valley Spurge 6/9/2007 Y

Fabaceae Acmispon parviflorus Small-Flowered Lotus 3/28/2007 Y

Fabaceae Acmispon wrangelianus Wrangel Lotus 3/4/2007 Y

Fabaceae Astragalus pauperculus Depauperate Milk-Vetch 3/25/2007 Y CNPS List 4, observed on thin soiled slopes 

Fabaceae Cercis occidentalis Western Redbud 3/28/2007 Y

Fabaceae Medicago polymorpha Common Bur-Clover 3/20/2007 N

Fabaceae Medicago praecox Mediterranean Bur-Clover 3/27/2007 N

Fabaceae Melilotus albus White Sweet-Clover 6/10/2007 N adjacent Mud Creek

Fabaceae Lotus corniculatus Bird's-Foot Trefoil 4/29/2007 N

Fabaceae Lupinus bicolor Bicolor Lupine 3/20/2007 Y

Fabaceae Lupinus nanus Sky Lupine 3/17/2007 Y

Fabaceae Trifolium bifidum var. decipiens Deseptive Clover 4/15/2007 Y

Fabaceae Trifolium ciliolatum Foothill Clover 5/5/2007 Y

Fabaceae Trifolium depauperatum var. depauperatum Dwarf Cowbag Clover 3/17/2007 Y

Fabaceae Trifolium dubium Little Hop Clover 4/8/2007 N

Fabaceae Trifolium fragiferum Strawberry Clover 6/9/2007 N adjacent Mud Creek

Fabaceae Trifolium glomeratum Sessile-Headed Clover 5/5/2007 N

Fabaceae Trifolium hirtum Rose Clover 3/17/2007 N

Fabaceae Trifolium microcephalum Small-Headed Clover 3/28/2007 Y

Fabaceae Trifolium olivaceum Olive Clover 3/25/2007 Y

Fabaceae Trifolium repens White Clover 4/29/2007 N

Fabaceae Trifolium subterraneum Subterranean Clover 3/17/2007 N

Fabaceae Trifolium willdenovii Tomcat Clover 3/24/2007 Y

Fabaceae Trifolium wormskioldii Springbank Clover 4/29/2007 Y

Fabaceae Trifolium variegatum White-Tipped Clover 3/28/2007 Y

Fabaceae Vicia sativa ssp. sativa Garden Vetch 3/17/2007 N

Fabaceae Vicia sativa ssp. nigra Garden Vetch 3/28/2007 N

Fabaceae Vicia villosa ssp. villosa Winter Vetch 3/17/2007 N

Fagaceae Quercus douglasii Blue Oak 3/17/2007 Y

AKA= Oswald, V. 2002

DATE= Observation

NATive: Y=yes; N=No
2/20/2018
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Fagaceae Quercus lobata Valley Oak 3/28/2007 Y

partial live tree growing in seasonal streambed; two medium sized trees on 

flood plain adjacent Mud Creek

Fagaceae Quercus wislizeni var. wislizeni Interior Live Oak 3/28/2007 Y

Gentianaceae Cicendia quadrangularis Timwort 3/25/2007 Y

Gentianaceae Zeltnera muehlenbergii June Centaury 4/29/2007 Y

Gentianaceae Zeltnera venusta Canchalagua 6/9/2007 Y adjacent Mud Creek

Geraniaceae Erodium brachycarpum Short-Fruited Stork's-Bill 3/17/2007 N

Geraniaceae Erodium botrys Long-Beaked Stork's-Bill 3/31/2007 N

Geraniaceae Erodium cicutarium Red-Stemmed Filaree 3/28/2007 N

Geraniaceae Geranium dissectum Cut-Leaved Geranium 3/28/2007 N

Geraniaceae Geranium molle Dove's-Foot Geranium 3/17/2007 N

Hypericaceae Hypericum perforatum ssp. perforatum Klamathweed 5/5/2007 N

Lamiaceae Lamium amplexicaule Giraffehead 3/24/2007 N

Lamiaceae Mentha arvensis American Wild Mint 6/9/2007 Y adjacent Mud Creek

Lamiaceae Monardella sheltonii Shelton's Coyote-Mint 3/28/2007 Y

Lamiaceae Pogogyne douglasii Douglas' Pogogyne 4/29/2007 Y

Lamiaceae Pogogyne zizyphoroides Sacramento Valley Pogogyne 3/24/2007 Y

Lamiaceae Scutellaria siphocampyloides Gray-Leaved Skullcap 5/5/2007 Y growing in a dry streambed

Lamiaceae Trichostema lanceolatum Vinegar-Weed 3/17/2007 Y

Juncaceae Juncus bufonius var. bufonius Common Toad-Rush 4/29/2007 Y adjacent Mud Creek
Juncaceae Juncus capitatus Leafy-Bracted Dwarf Rush 3/20/2007 N observed in vernal areas, considered uncommon in Jepson
Juncaceae Luzula subsessilis Sessile Wood-Rush 4/29/2007 Y

Liliaceae Calochortus luteus Yellow Mariposa-Lily 4/29/2007 Y

Liliaceae Fritillaria pluriflora Adobe-Lily 3/31/2007 Y CNPS List 1B, with Zigadenus & blue oaks

Limnanthaceae Limnanthes alba ssp. alba White Meadowfoam 4/15/2007 Y single plant observed along Mud Creek

Limnanthaceae Limnanthes floccosa ssp. floccosa Woolly Meadowfoam 3/4/2007 Y CNPS List 4, populations & habitat seemed mixed

Limnanthaceae Limnanthes floccosa ssp. californica Shippee Meadowfoam 3/20/2007 Y CNPS List 1B, CE, FE.

Linaceae Hesperolinon californicum California Western-Flax 5/5/2007 Y growing on open grassland/pasture

Lythraceae Lythrum hyssopifolia Hyssop Loosestrife 6/9/2007 N adjacent Mud Creek

Malvaceae Sidalcea calycosa ssp. calycosa Annual Checkerbloom 4/29/2007 Y marshy area adjacent Mud Creek

Malvaceae Sidalcea robusta Butte County Checkerbloom 5/5/2007 Y CNPS List 1B

Melanthiaceae Toxicoscordion fremontii Fremont's Zigadene 3/28/2007 Y

Molluginaceae Mollugo verticillata Indian-Chickweed 4/29/2007 N

Montiaceae Calandrinia menziesii Redmaids 3/17/2007 Y

Montiaceae Claytonia parviflora ssp. parviflora Small-Flowered Miner's Lettuce 3/17/2007 Y

Montiaceae Claytonia perfoliata ssp. perfoliata Common Miner's Lettuce 3/17/2007 Y

Montiaceae Montia fontana Water Montia 3/4/2007 Y

Moraceae Ficus carica Edible Fig 4/15/2007 N one small tree observed adjacent Mud Creek

Myrsinaceae Lysimachia arvensis Scarlet Pimpernel 4/15/2007 N adjacent Mud Creek

Oleaceae Fraxinus latifolia Oregon Ash 4/15/2007 Y adjacent Mud Creek
Onagraceae Clarkia purpurea ssp. quadrivulnera Purple Clarkia 4/11/2007 Y
Onagraceae Epilobium ciliatum ssp. ciliatum Fringed Willowherb 6/9/2007 Y adjacent Mud Creek
Onagraceae Epilobium torreyi Torrey's Spike-Primrose 6/9/2007 Y adjacent Mud Creek

AKA= Oswald, V. 2002

DATE= Observation

NATive: Y=yes; N=No
2/20/2018
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Orobanchaceae Castilleja affinis Lay & Collie's Indian-Paintbrush 5/5/2007 Y

Orobanchaceae Castilleja attenuata Valley-Tassels 3/31/2007 Y  

Orobanchaceae Triphysaria eriantha ssp. eriantha Johnnytuck 3/4/2007 Y

Papaveraceae Eschscholzia caespitosa Foothill-Poppy 3/17/2007 Y

Papaveraceae Eschscholzia lobbii Fryingpans 3/20/2007 Y

Papaveraceae Meconella californica California Fairypoppy 2/25/2016 Y collected

Phrymaceae Mimulus douglasii Purple mouse ears 2/25/2016 Y

Phrymaceae Mimulus glaucescens Shield-Bracted Monkey-Flower 4/15/2007 Y CNPS List 4, adjacent Mud Creek & Sheep Hollow Creek

Phrymaceae Mimulus guttatus Seep Monkey-Flower 3/27/2007 Y

Pinaceae Pinus sabiniana Gray Pine 3/28/2007 Y

Plantaginaceae Collinsia sparsiflora var. sparsiflora Few-Flowered Collinsia 3/4/2007 Y

Plantaginaceae Collinsia tinctoria Sticky Chinese-Houses 5/5/2007 Y growing in a dry streambed

Plantaginaceae Keckiella breviflora var. glabrisepala Gaping Keckiella 5/5/2007 Y

Plantaginaceae Kickxia elatine Sharp-Leaved Fluellin 4/15/2007 N adjacent Mud Creek

Plantaginaceae Penstemon heterophyllus var. purdyi Purdy's Beardtongue 6/9/2007 Y several plants observed, vegetative state only

Plantaginaceae Plantago elongata Elongate Plantain 3/20/2007 Y

Plantaginaceae Plantago erecta Erect Plantain 3/17/2007 Y

Plantaginaceae Plantago lanceolata English Plantain 4/15/2007 N adjacent Mud Creek

Plantaginaceae Veronica anagallis-aquatica Water Speedwell 5/15/2007 N Mud Creek

Plantaginaceae Veronica peregrina ssp. xalapensis Purslane Speedwell 4/8/2007 Y

Platanaceae Platanus racemosa Western Sycamore 4/29/2007 Y one medium sized tree adjacent Mud Creek

Poaceae Aira caryophyllea Silver European Hairgrass 3/17/2007 N

Poaceae Alopecurus saccatus Vernal Pool Fescue 3/24/2007 Y

Poaceae Avena barbata Slender Wild Oat 3/17/2007 N

Poaceae Avena fatua Wild Oat 5/5/2007 N

Poaceae Briza maxima Greater Quaking-Grass 4/29/2007 N adjacent and growing into Mud Creek

Poaceae Briza minor Lesser Quaking Grass 3/24/2007 N

Poaceae Brachypodium distachyon False-Brome 5/5/2007 N

Poaceae Bromus hordeaceus Soft Chess 3/17/2007 N

Poaceae Bromus madritensis ssp. rubens Red Brome 3/31/2007 N

Poaceae Bromus sterilis Poverty Brome 5/5/2007 N

Poaceae Bromus tectorum Cheatgrass 5/5/2007 N

Poaceae Crypsis vaginiflora African pricklegrass 6/9/2007 N adjacent Mud Creek

Poaceae Cynodon dactylon Bermuda-Grass 6/9/2007 N adjacent Mud Creek

Poaceae Cynosurus echinatus Hedgehog Dogtail 3/28/2007 N

Poaceae Deschampsia danthonioides Annual Hairgrass 3/25/2007 Y

Poaceae Digitaria ischaemum Smooth Crabgrass 4/29/2007 N adjacent Mud Creek

Poaceae Elymus caput-medusae Medusa-head 3/17/2007 N NOXIOUS WEED, C List

Poaceae Elymus ponticus Tall Wheatgrass 6/10/2007 N adjacent Mud Creek
Poaceae Festuca bromoides Six-Weeks Fescue 3/17/2007 N
Poaceae Festuca microstachys Fringed Fescue 3/24/2007 Y
Poaceae Festuca microstachys Hairy-Leaved Fescue 3/31/2007 Y
Poaceae Festuca microstachys Few-Flowered Fescue 3/25/2007 Y

AKA= Oswald, V. 2002

DATE= Observation

NATive: Y=yes; N=No
2/20/2018

5 of 7



Department of Fish and Game Stone Ridge Ecological Reserve City of Chico, Butte County

FAMILY GENUS SPECIES var/ssp A.K.A. DATE

N

A

T COMMENTS

Poaceae Festuca myuros Rattailed Fescue 3/31/2007 N

Poaceae Festuca perennis Ryegrass 3/17/2007 N

Poaceae Gastridium phleoides Nitgrass 6/9/2007 N

Poaceae Glyceria X occidentalis Western Mannagrass 4/29/2007 Y adjacent Mud Creek

Poaceae Hordeum marinum ssp. gussoneanum Mediterranian Barley 3/17/2007 N

Poaceae Hordeum murinum ssp. leporinum Hare Wall Barley 3/24/2007 N

Poaceae Koeleria gerardi Bristly Koeler's Grass 4/29/2007 N

Poaceae Muhlenbergia rigens Deergrass 3/28/2007 Y several clumps observed along Mud Creek and Sheep Hollow Creek

Poaceae Panicum acuminatum var. acuminatum Western Panicgrass 6/9/2007 Y adjacent Mud Creek; does not occur in CA according to JMT2

Poaceae Paspalum dilatatum Dallisgrass 6/9/2007 N adjacent Mud Creek

Poaceae Poa annua Annual Bluegrass 3/17/2007 N

Poaceae Poa bulbosa Bulbous Bluegrass 3/28/2007 N

Poaceae Poa secunda ssp. secunda One-Sided Bluegrass 3/31/2007 Y
Poaceae Poa tenerrima Delicate Bluegrass 3/17/2007 Y growing in recently dried vernal swells & seasonal streambeds
Poaceae Polypogon monspeliensis Annual Beardgrass 4/29/2007 N

Poaceae Scribneria bolanderi Scribner's-Grass 3/20/2007 Y

Poaceae Stipa pulchra Purple Needlegrass 6/9/2007 Y occasional near waterways in blue oak woodlands
Polemoniaceae Gilia tricolor ssp. tricolor Bird's-Eye Gillia 3/24/2007 Y

Polemoniaceae Leptosiphon bicolor Bicolored Linanthus 3/17/2007 Y

Polemoniaceae Leptosiphon filipes Wild Baby's-Breath 3/25/2007 Y

Polemoniaceae Microsteris gracilis Slender Phlox 3/4/2007 Y

Polemoniaceae Navarretia heterandra Tehama Navarretia 4/15/2007 Y CNPS List 4

Polemoniaceae Navarretia intertexta Needle-Leaved Navarretia 5/5/2007 Y

Polemoniaceae Navarretia leucocephala ssp. leucocephala White-Flowered Navarretia 3/24/2007 Y

Polemoniaceae Navarretia pubescens Downy Navarretia 4/29/2007 Y

Polemoniaceae Navarretia tagetina Marigold Navarretia 4/29/2007  Y 

Polemoniaceae Navarretia viscidula Sticky Navarretia 6/9/2007 Y

Polygonaceae Chorizanthe polygonoides var. polygonoides Knotweed Spineflower 3/25/2007 Y

Polygonaceae Eriogonum nudum var. pubiflorum Hairy-Flowered Buckwheat 3/28/2007 Y

Polygonaceae Periscaria maculosa Lady's-Thumb 4/29/2007 N adjacent Mud Creek

Polygonaceae Periscaria punctata Dotted Smartweed 6/10/2007 Y adjacent Mud Creek

Polygonaceae Pterostegia drymarioides Pterostegia 3/28/2007 Y

Polygonaceae Rumex salicifolius Willow Dock 4/15/2007 Y adjacent Mud Creek

Polygonaceae Rumex crispus Curly Dock 3/31/2007 N

Primulaceae Primula clevelandii var. patula Lowland Shootingstar 3/17/2007 Y

Primulaceae Primula hybrid? 3/4/2007 Y

Pteridaceae Pentagramma triangularis ssp. triangularis Gold-Backed Fern 3/17/2007 Y

Ranunculaceae Delphinium hansenii ssp. hansenii Hansen's Larkspur 5/5/2007 Y
Ranunculaceae Delphinium variegatum ssp. variegatum Royal Larkspur 3/17/2007 Y

Ranunculaceae Ranunculus arvensis Field Buttercup 4/15/2007 N

Ranunculaceae Ranunculus canus Sacramento Valley Buttercup 3/28/2007 Y

Ranunculaceae Ranunculus muricatus Prickle-Seeded Buttercup 3/31/2007 N

Rhamnaceae Ceanothus cuneatus var. cuneatus Buckbrush 3/28/2007 Y

AKA= Oswald, V. 2002

DATE= Observation

NATive: Y=yes; N=No
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Rhamnaceae Frangula californica ssp. tomentella Hoary Coffeeberry 3/28/2007 Y

Rhamnaceae Rhamnus ilicifolia Holly-Leaved Redberry 6/9/2007 Y two plants obs. to date

Rosaceae Cercocarpus betuloides var. betuloides Birch-Leaved Mountain-Mahogany 5/5/2007 Y only a few shrubs observed along Sheep Hollow Creek

Rosaceae Drymocallis glandulosa Sticky Cinquefoil 3/28/2007 Y one population observed hanging on a moist, shaded creek rockface

Rosaceae Rubus armeniacus Himalayan Blackberry 4/15/2007 N adjacent Mud Creek

Rubiaceae Cephalanthus occidentalis var. californicus California Button-Willow 4/29/2007 Y adjacent Mud Creek

Rubiaceae Crucianella angustifolia Crosswort 5/5/2007 N

Rubiaceae Galium aparine Cleavers 3/17/2007 Y

Rubiaceae Galium parisiense Wall Bedstraw 5/5/2007 N

Rubiaceae Sherardia arvensis Field-Madder 3/28/2007 N

Salicaceae Populus fremontii ssp. fremontii Fremont's Cottonwood 3/28/2007 Y

on se property several small trees on edge of a seasonal stream; one med. 

size tree adjacent Mud Creek

Saxifragaceae Lithophragma bolanderi Bolander's Woodlandstar 3/28/2007 Y

Saxifragaceae Micranthes integrifolia Smooth Leaf Saxifrage 2/25/2016 Y collected

Saxifragaceae Micranthes californica Green's Saxifrage 2/26/2016 Y collected

Scrophulariaceae Verbascum balattaria Moth Mullein 3/15/2007 N adjacent Mud Creek

Scrophulariaceae Verbascum thapsus Woolly Mullein 3/15/2007 N adjacent Mud Creek

Selaginellaceae Selaginella hansenii Hansen's Spike-Moss 3/4/2007 Y

Tamaricaceae Tamarix gallica French Tamarisk 3/11/2007 N population along Mud Creek at nw end of property

Tecophilaeaceae Odontostomum hartwegii Hartweg's Odontostomum 4/8/2007 Y

Themidaceae Brodiaea californica California Brodiaea 4/29/2007 Y

Themidaceae Brodiaea elegans ssp. elegans Elegant Brodiaea 4/29/2007 Y

Themidaceae Brodiaea minor Bluestars 4/8/2007 Y

Themidaceae Dichelostemma capitatum ssp. capitatum Bluedicks 3/17/2007 Y

Themidaceae Dichelostemma multiflorum Round-Toothed Ookow 3/28/2007 Y

Themidaceae Dichelostemma volubile Twining Ookow 4/15/2007 Y

Themidaceae Triteleia bridgesii Bridges' Triteleia 5/5/2007 Y

Themidaceae Triteleia hyacinthina Wild Hyacinth 3/24/2007 Y

Themidaceae Triteleia laxa Ithuriel's Spear 3/17/2007 Y

Themidaceae Triteleia lilacina Glassy Wild Hyacinth 3/28/2007 Y

Typhaceae Typha domingensis Southern Cattail 6/9/2007 Y adjacent Mud Creek

Valerianaceae Plectritis ciliosa Long-Spurred Pink Plectritis 3/31/2007 Y

Valerianaceae Plectritis ciliosa Short-Spurred Pink Plectritis 3/17/2007 Y

Valerianaceae Plectritis macrocera White Plectritis 3/28/2007 Y

Violaceae Viola douglasii Douglas' Violet 3/17/2007 Y

Vitaceae Vitis californica California Wild Grape 3/28/2007 Y occasional along several of the larger drainages

AKA= Oswald, V. 2002

DATE= Observation

NATive: Y=yes; N=No
2/20/2018
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APPENDIX B 



Workflow for Aligning Monitoring Photos in Photoshop 

This procedure provides a rough outline of a technique for aligning monitoring photos taken from the 

same location using Photoshop CS6. 

1. Open Photoshop CS6 

2. Under “File”, select “Scripts” > “Load Files into Stack” 

3. Select “Browse” and select all monitoring photos you would like to align 

a. Only check “Attempt to Automatically Align Source Images” if there are lots of 

buildings or other visually distinct aspects to the image, and even then, this may not 

work well. If the result does not look good, start over and uncheck this box. 

4. Select “Image”, and “Canvas Size” and increase the vertical and horizontal canvas size by a few 

inches. 

5. Select the top layer in the layers window, select “Filter” and “Lens Correction…” For “Edge” 

select “Edge Extension”. Select OK.  

a. NOTE: For photos taken with an SLR camera (Nikon d3100/d3300) a lens profile is 

available, and should be used. The Native Plant Program point and shoot Sony camera 

does not have a lens profile, so skip the lens correction step for photos taken on the 

Sony.  

6. Use the eye button to make the top layer that was just corrected invisible, click on the next 

layer down to select it, and repeat Step 5 for all remaining monitoring photos.  

7. Make the top layer visible again and click it to select it in the layers window. Click and hold the 

eyedropper icon in the tools window, and select the ruler tool in the submenu. 

8. Click and hold on a specific feature on the horizon on the left side of the image, and drag a ruler 

line to a specific feature on the horizon on the right side of the image. Click the “Straighten 

Layer” button at the top of the window. Repeat steps 6 and 7 for the remaining layers so that 

the horizon is straightened in the same way for all monitoring photos. 

9. Select a reference photo with lots of landmarks and identifiable features, and move it down to 

the bottom layer in the layers window. (This will be your Reference Photo)  

10. Make all layers invisible in the layers window, except for the bottom two layers. Make the layer 

above the bottom layer about 50 percent transparent by selecting it in the layers window, and 

using the “Opacity” slider, so that you can see features from both images at the same time.  

11. Use the “Move Tool” by pressing V on the keyboard, and dragging the top layer so that it 

matches the bottom layer as best as possible. Getting the horizon to match as much as possible 

is a good first step. Matching features in the foreground is more difficult. There are several 

techniques that can be used to help with this: 

a. Resizing the layer by holding the shift key (to maintain aspect ratio) and clicking and 

dragging a corner of the layer.  -> be sure that “Show Transform Controls” is checked.  

b. “Edit” > “Transform” > “Warp” can be used to drag features to where they need to be. 

If a rock or tree needs to be moved to line up with the same rock or tree underneath, 

simply drag it and move it. You will likely need to go back to other areas of the photo to 

stretch everything into the right place. Just work on the photo until you are happy with 



the result. (Important note: do not accept the changes and apply the transformation by 

pressing the “enter” key until you are completely happy with the result. Every time you 

accept a transformation, the act is destructive, and it permanently degrades the quality 

of the image) 

c. “Edit” > “Transform” > “Perspective” can also be used if a side of the image is skewed in 

one way or the other. Grab the edge you want to move and move it. I have only used 

this successfully a few times, typically if most to the telephone poles are leaning in one 

direction, for instance.  

d. Once you have begun transforming the layer, you cannot turn the layer on and off to 

check your work anymore, and you should therefore use the “Opacity” slider to see 

what is underneath and check your work. 

12. When you have completed a layer, make it invisible with the eye button, and make the next 

layer above visible, select it, and continue with Steps 8, 9 and 10 until you have edited all of the 

layers. 

13. Select “File” > “Save As” and save the photoshop file as the photopoint name in the appropriate 

location on the U Drive, for example: U:\Groups\HCPB\Shared Folders\NPP\Section 

6\2014\Priority Plant Surveys\Project Files\Butte County Limnanthes Files\Stone Ridge\All 

renamed photos here for comparison\Aligned Photos\Aq  

(You might need to make a new Aligned photos folder in renamed photos folder) 

14. Make all layers visible and select all layers. Select “View” > “Show” > “Layer Edges” to give you 

an idea of where all of the layers overlap. Select the Rectangular Marquee Tool from the toolbar 

window (a dashed rectangle).  

15. Draw a selection within the area that all (or most) of the layers overlap. -> The layer edges will 

disappear once you start to draw your rectangle so be sure to get a good idea of where to draw 

before you start. 

16. After the photoshop file has been saved, crop the image down by selecting “Image” > “Crop” 

17. Make only the top layer visible and select it. If there are any areas along the edges where you 

can see the transparency underneath and want to fill it in with camouflage, select the area using 

the magic wand tool from the toolbar. After selecting the transparency, select “Select” > 

“Modify” > “Expand” and increase the selection by 5 pixels. 

18. Next click “Edit” > “Fill…” and select “Content Aware” to fill the blank areas.  

19. Next click “File” > “Save as”, change the file type to JPEG and save the file in the appropriate 

photopoint folder on the U drive, with the filename corresponding with that photopoint and the 

date the photo was taken. 

20. Repeat steps 15, 16 and 17 for the remaining layers.  
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